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Аннотация 

 

Ушбу малакавий битирув иши Adobe Flash дастурий воситасининг 

анимация яратиш бўйича имкониятларини ўрганиш ва унда одам 

ҳаракатининг  анимациясини яратишга бағишланган. Мақсадга эришиш учун 

Adobe Flash дастури ўрганиб чиқилди. Одам ҳаракати моделлари ўрганилди. 

Одам юриши ва югуриши анимацияси алгоритми силуэт формасида яратилди. 

Шунингдек, Одам югуриши бўйича турли персонажларнинг югуриши мисол 

тариқасида ишлаб чиқилди.  

Аннотация 

Настоящая дипломная работа посвящена к изучению возможностей 

программного средства Adobe Flash по созданию анимации и созданию 

анимации движения человека. Для выполнения поставленной задачи изучено 

программное обеспечение Adobe Flash, также модели движения человека. 

Разработана алгоритм и анимации двигающего и бегущего человека в форме 

силуэта. Также разработаны анимация бега различных персонажей.      

 

The summary 

 

The present thesis is devoted to studying the possibilities of Adobe Flash 

software tool for creating animation and animation of human movement. To 

accomplish the task studied software Adobe Flash, also models of human 

movement. The algorithms and animations move and the running man in the form 

of the silhouette. Also developed animation running different persons. 

 

 

 



КИРИШ 

 

Мавзунинг долзарблиги. Республикамиз   ўз  мустақиллигига 

эришганидан сўнг  жамиятимизда бир қатор қонунлар ва умуммиллий  

дастурларларнинг қабул қилиниши, ҳуқуқий демократик  жамиятни  барпо  

этишда ва буюк келажак сари олға қадам қўйишимизда мустақил пойдевор 

бўлиб хизмат қилмоқда. Республикамизда барча соҳа сингари таълим 

тизимида ахборот технологияларидан самарали фойдаланишга катта эътибор 

қаратилмоқда. Шу сабабли Республикамизда ахборот технологияларини 

ривожлантиришга доир бир нечта давлат қонунлари, фармонлари ва 

Президент қарорлари қабул қилинди. Жумладан: Ўзбекистон Республикаси 

Президентининг “Замонавий ахборот-коммуникация технологияларини янада 

жорий этиш ва ривожлантириш чора-тадбирлари  тўғрисида”ги қарори (21 

март 2012 й.) ва бошқалар. 

Таълим тизимидаги ислоҳотларни амалда жорий қилишда ўқитишнинг 

илғор педaгогик технологияларини қўллаш асосида талабаларга жаҳон 

андозалардаги билим, кўникма, малакаларни шакллантириш ўқув жараёнини 

моддий – техника ва ахборот базаси билан таъминлаш юқори даражали 

малакали кадрларни тайёрлаш сифатли ўқув – услубий, илмий ҳамда дидактик 

материаллар яратиш, таълим тизими фан ва ишлаб чиқариш ўртасида ўзаро 

самарали алоқадорлик ўрнатиш, таълимнинг долзарб масалалардан 

ҳисобланади.    

Шунингдек, телевизион технологияларининг кундан кунга ривожланиб 

бориши, экран маданияти каби тушунчаларнинг бизнинг ҳаётмизган кириб 

келиши, турли соҳаларда кўргазмали материалларни яратиш ва уларни ҳаёт 

жабҳаларида қўллашни талаб этади.  

Айни пайтда телевизион кўрсатувлар, рекламалар ва албатта ўқув 

материалларини яратишда анимациянинг аҳамияти катта. Дастлабки 

анимацион материаллар жуда оддий ва эски технологиялар орқали яратилган. 



Ахборот технологияларининг ривожланиши натижасида анимацияларни 

яратишнинг мисли кўрилмаган имкониятлари вужудга келди.  

Жумладан, Flash технологиясининг пайдо бўлиши мультипликаторлар 

орзусининг ушалгани деб қаралса муболаға бўлмайди. Flash 

технологиясининг имконияти бу борада нақадар каттаки, унда нафақат 

фильмлар яратиш балки Action Script тили ёрдамида интерактив 

анимацияларни яратиш мумкин. Flash технология асосий вазифаси графика ва 

анимация бўлган интерактив дастурларни  яратишдан иборатдир. Flash 

яратувчилари унинг ёрдамида олинган филмларни ишлатилишини яна икки 

бошқа вариантларини ҳам ишлаб чиқишган. Биринчидан Flash филмларини 

мустақил (Wеб броузерда боғлиқ бўлмаган ҳолда) намойиш этилиши, 

иккинчиси эса Flash филмларини бошқа форматларига ўтказилишидир.  

Фильмларни флеш ёрдамида яратиш ва тахрирлаш вақтида муаллиф fla 

форматига  эга файллар билан ишлайди. Бу Flash мухарририни ички 

форматидир ва у фақат Flashда тушинарлидир. Wеб-броузер ёрдамида 

намойиш этиш  учун мўжалланган филмлар swf форматига ўтказиб олиши 

зарур. Юқорида таъкидлаб ўтилгандек, ушбу формат броузерлари (Internet 

Explorer, Natscape  ва Opera)  сўнги версияларида намойиш этилиши мумкин  

ёки махсус Flash плеер ёрдамида ҳам намойиш этилиши мумкин.  

Ушбу Flash player Flash мухарири таркибига мустақил дастур сифатида 

киради ва swf файллар мухаририсиз ҳам  Flash плеерда намойиш этилиши 

мумкин. Шу билан бирга филмнинг барча функсионал ва интерактив 

имкониятлар сақланиб қолади.  

Flash филмларини ”автоном” намойиш этилиши иккинчи вариант бу-

Универсал Медиа плеердан фойдаланишдир. Бунинг учун Flash филм avi 

форматида экспорт қилиниши керак. Лекин бу ҳолда филмни ҳажми айрим 

ҳолларда юз баробар ортиб кетиши мумкин.  

Дастурлаш тилларида объект фақат шу объектга қўлланиши мумкин 

бўлган атрибутлар (хусусиятлар)тўплами ва усуллар рўйхати билан 

ифодаланади. Ҳар бир синф объектлари учун ўз атрибутлар ва усуллар 



тўплами белгиланган. Масалан “тугма” объекти учун атрибутлар сифатида 

ишлатилиши мумкин. Юқорида санаб ўтилган Flash филмларни экспорти 

уларнинг динамикасини (у ёки бу даражада) сақланишини таминлайди. Лекин 

зарур бўлганда Flashдан оддий график мухарири сифатида ҳам фордаланиш 

мумкин. Унинг ёрдамида яратилган тасвир сўнг бирор бир график формат 

(векторли ёки растрли)га ўтказилиши мумкин. Шу билан Flash филмга бошқа 

график форматлардан берилган тасвирларни қўшиш(импорт қилиш) 

имкониятига эга. Flash филмларни намойиш этилишини турли усуллари 

мавжудлигига қарамасдан бугунги кунда бу техналогияни қўлланишининг 

асосий йўналиши бу чиройли ва динамик Wеб саҳифалар яратишдир.  

Flash филмларда товушни ишлатишни бир неча усулларини тақдим этади. 

Сиз филмни сюжети ва фойдаланувчи бажарган амалдан қатъий назар 

тўхтамайдиган амални яратишингиз мумкин. Алтернатив вариант анимация ва 

товушни синхронлаш. Бундан ташқари Flash тугмачаларига товуш 

ишлатишингиз мумкин.  

Тадқиқот объекти. Битирув малакавий ишнинг тадқиқод объекти бўлиб 

анимацияларни ва видео файлларни яратиш технологиялари  ҳисобланади.     

Тадқиқот предмети.  Анимацион тасвирларга асосланган файлларни 

яратиш усуллари, ҳаракатни моделлаштириш ва анимацион файл яратиш 

методологияси ва уларни қўллаш усуллари.  

Тадқиқот мақсади. Одам югуришида тана органларининг ҳаракатини 

ўрганиш, уни моделини ва Adobe Flashда анимацион дастурини ишлаб чиқиш.  

Тадқиқод вазифалари.  Анимацион файллар ва уларни яратиш дастурий 

воситаларини ва қайта ишлашга мўлжалланган дастурларни ўрганиш. 

Анимацион файлларни яратишнинг технологик бoсқичлaрини таҳлилини 

ўтказишдан иборат. 

Тадқиқотнинг амалий аҳамияти. Одамнинг юриши, югуриши, 

зинапоядан кўтарилиши моделлари ўрганилди ва анимацион файллари 

яратилди. Ушбу файллардан электрон ўқув-методик мажмуа ресурсларини 

яратишда фойдаланиш мумкин.   



I БОБ. АНИМАЦИЯНИНГ ПАЙДО БЎЛИШИ ВА АНИМАЦИЯ 

ЯРАТИШ ТЕХНОЛОГИЯЛАРИ 

 

1.1. Анимация тушунчаси 

«Анимация» соҳасининг долзарблиги бугунги кунда ҳеч қандай шубҳа 

қолдирмайди. Бундан тахминан 100 йиллар дастлабки мультфильмлар пайдо 

бўлиб, ҳаммани ҳайратга солган эди. Замонавий анимацион 

технологияларнинг вужудга келиши,  мультимедиа проектлар ва 

презентацияларнинг асосий элементига айланди ва улар борган сари интернет 

саҳифаларда кўпайиб бормоқда. Шунингдек, анимация телевидениеда ҳам 

кенг кўламда қўлланилмоқда. Масалан. Кўплаб телекомпаниялар 

заставкаларни яратишда компьютер анимациясидан фойдаланишади. 

Видеомаҳсулотларни яратишда профессионал видео элементларидан ва 

компьютер анимациялари приёмларидан фойдаланилади. 

Бугунги кунда яратилган анимация, жуда турли тумандир. Афсуски, 

компьютер техникаси имкониятларининг ошиши билан кўпчиллик инсонлар 

учун ўз тасаввуридаги ғояларини кўриш ўрнига энг сўнгги модадаги махсус 

эффектларни кўришга тўғри келмоқда. 

Ушбу параграфда анимацияни яратишнинг мавжуд технологияларининг 

систематикаси ва анимацияларни яратиш принциплари кўриб чиқилади.  

Инсоният мавжуд эканки ўз санъатида ҳаракатни ифодалашга интилган. 

Ҳаракатни расм орқали ифодалашга бўлган дастлабки уринишлар эрамиздан 

олдинги 2000 йилларда Мисрда бўлган.  

Яна бир мисол. Шимолий Испаниянинг ғорларида топилган. Бу саккиз 

оёқли тўнғиз кўринишида ифодаланган.  

Бугунги кунда ҳаракатни ифодалаш учун анимация воситалари орқали 

амалга оширилади. Кино, телевидение ва компьютер графикаси ёрдамида 

ҳаракатни расмлар ёки кадрлар кетма-кетлигини  маълум частотада сунъий 



равишда образларни кўриш орқали қабул қилишни таъминлашга - анимация 

дейилади. 

Узлуксиз ҳаракатдан фойдаланувчи видеодан фарқли ўлароқ, анимация 

бир бирига боғлиқ бўлмаган расмлар тўпламидан иборат. «Анимации» – 

«мультипликация» - синоними жуда кенг тарқалган. Анимация ва 

мультипликация – санъат турининг икки кўринишдаги таърифидир. Бизга 

кўпроқ маълум бўлган термин «мульти» лотинча сўз – кўп сўзидан олинган 

бўлиб, кўп расм маъносини англатади. Қаҳрамонни «жонлатириш» учун 

расмларни керакли миқдорда такрорлаш зарур: секундига 10 дан 30 гача 

чизилган кадрлар. 

Аммо, шуни таъкидлаш жоизки, жаҳонда «анимация» (лотинчадан 

таржима қилинганда «анима» – жон, «анимация» – жонлантириш 

тушунилади). Анимацион кинонинг замонавий техник ва бадиий 

имкониятларини бундан ортиқ таърифлаш мумкин эмас, чунки анимация 

усталари ўз қаҳрамонларини яратишда, жонлантиришда ўз меҳрларини ҳам 

беришади. 

 

1.2. Анимация тарихи 

Ихтиёрий санъат сингари анимация ҳам ўз тарихига эга. Анимацияга 

асосланган кўриш орқали қабул қилишнинг инертлик принципи 1828 йил 

биринчи бўлиб, француз Паул Рогет   томонидан намойиш этилган. Намойиш 

объекти сифатида диск олинган эди ва унинг бир томонида қуш расми 

чизилган ва иккинчи томонида қафас сурати туширилган. Дискни 

айлантиришда томошабинда қуш гўёки қафасда жойлашгандек иллюзия ҳосил 

қилган.  

Анимация яратишнинг биринчи амалий усулини Том А. Eдисон    

томонидан фотокамера ва проекторнинг яратилиши асос бўлган. 

1906 йил Стюард Блактон томонидан  «қувноқ юзларнинг кулгили 

ифодалари»  қисқа фильм яратилди. Муаллиф доскада расм чизади, уни 

суратга олади ва ўчиради, расм чизади, уни суратга олади ва ўчиради....  



Анимацая дунёдида хақихий ревалюцайни Америкалик рассом, режиссёр 

ва прадюссер Уолт Дисней (1901-1966) кўрсатди. 

У 1923 йилда “Алиса мўжизалар мамлакатида ” серясини намойиш этди. 

1928 йилда эса Микки Маус қахрамон асосида мусиқавий мултифилм “Вилли 

Кемачи ”ни кейинчалик дунё болалари муҳаббати қувончига  эришган  

Доналд Дак ўрдакча ни яратди. Дисней студияси ижодкорлари қилинган 

ишлари учун 12 та “Оскар” мукофотини олишган. 

1913 йил Японияда 1 анимация эксприменти  ўтказилиши бошланди. 1917 

йилда эса 1минутдан 5 минутгача бўлган анимацион филм ишлаб чиқилди. Бу 

филмлар ҳар бир рассомларни ишлари бўлиб, европа, америка 

мултипикликаторлари  тажрибаларини бирлаштириб ишланган эди ва шу 

кўринишда япон стилидаги “аниме” деб номланган анимця дунё келди. 20- 

йилларда япон ананвий стили графигида чизилган япон , хитой этаклари 

асосида классик аниме экранлаштирилган эди. ОЪша вақтнинг  персонажни 

қоғоозга туширишда Симокава Декотен, Коти Дзюнити, Китайно Сейтаро, 

Ямомота Санае, Мурата Ясудзи ва Офудзи Ноборулар машҳур аниматларидан 

ҳисобланишган.   

1932 йили японияда биринчи анимация этудияси яратилди ва 1933 йилда 

эса биринчи овозли анимация яртилди. 

1943 йилда ҳукуматни қарорига асосан биринчи тўлиқ метражли 

“Момоторо, денгиз бургути” номли анмацион филим олинди. 

60-70 йилларда япон анимциясини Тудзуки Осаму номи билан боғлиқ. У 

томашабин оммасини ёриб киришда тасирчан аниме филмлари билан донг 

қозонди.    

Шу аснода 70 йилларда аниме Японияда энг оммабоп пуллик тижорат 

санатига айланди. ОЪша йилларда аниме телевизион сериал  сифатида асосий 

рол ўйнади. 

Россия экранларида турли йилларда япон филимлари намойиш этилди 

булардан: “Жодугар Салли”, “Eтик кийган мушик”, “Шарпалар кемаси”, 



“Асалари Мая саргузаштлари ”, “Конан-келажакдан келган бола” ва 

бошқалар. 

 

1.3. Анимация яратиш технологиялари 

Ҳозирги даврда турли анимация яратувчи технологиялар мавжуд:  

1. Классик (ананавий) анимаця- бу расмларни кетма-кетлик билан 

ўтказиш, ҳар бир расм алоҳида чизилган бўлади. Бу кўп меҳнат сарф этади, 

анматрлар ҳар бир кадрда расмларни алоҳида ишлашлари лозим бўлади. 

2. Стоп-кадрли (қўғирчоқ) анимация- бунда обектни ҳавода шундай 

жойлаштриладики ҳаракат кадрга олинади ва тохтатилади ундан сўнг  яна 

бошқа ҳаракатлар  тасвирга олинади.  

3. Спрайт анимаця- бу дастурлаш тиллари асосида амалга оширилади. 

4. Морфинг- бир обектдан бошқасигача бўлган ҳаракат 

генерасияланди яни, тахминий ҳисобланди ва кадрлар ясалди. 

5. Рангли анимация-бунда обектнинг ранг ҳолати ўзгартирилади. 

6. 3Д-анимация- бу  махсус дастурлар асосида яратилиб( мисол учун, 

3Д МАХ) тасвирни фазода 3 ўлчамда, турли нуқталар асосида яратилади. 

Бундай дастурлар турли обектлар, ранглар жамланмаси, текстуралар билан 

бойитилган ва ҳар бир кадрга ўзгача жило бериши билан бойитилган бўлади. 

7. Ҳаракатни  ушлаш  (Мотион Cаптуре)- биринчи анимацион 

ёЪналиш реал вақт давомида реал воқейликни акс эттириш имкони беради. 

Махсус датчик инсонга ўрнатилади ва инсонни ҳаркати нуқталари 

компютерга моделлаштирилади. Кейинчалик ҳаракат рақамлштирилиб 

тасвирга бирлаштрилиб анимацион ҳаракат яралади. 

 

1.4. Анимация принциплари 

Анимацион филмларни яратишда умумий принсиплар қўлланилади 

Шулардан асосийси қуйидагилар: 

1. “Қисқариш ва Чўзилиш” Бу принцип анимациа дунёсида революция 

бўлди. Принципнинг моҳияти шундан иборатки, ҳар бир  трик танаҳаракат 



вақтида ҳар доим қисқарди ва узяди. Сакрашдан олдин қисақаради ҳудди 

пуржинага ўхшаб, скараш вақтида эса узаяди. Бу  Асосий қоидани ҳардоим 

кўрамиз- агар персонаж чўзилса (стретч – Й ўқи бўйлаб шаклни ўзгриши), у 

албатта қисқариши шарт ўз мувозанатини сақлаш учун. (сқуаш – Х бўйлаб 

шаклни ўзгартириш). 

2. “Ҳаракатга таёрланиш” Реал ҳаётда қандайдур ҳаракат содир бўлди 

дейлик, инсон ҳар доим ҳаракат қилишга таёрланади, Масалан, сакрашдан 

олдин ўтиради, қўллар ҳаракати орқага кетади. Бу ҳаракат ҳаракати дейилади. 

Ҳар бир персонажни ишлашда бундай ҳаракатларга алоҳида этибор беилади.  

Бундай ҳаракатлар томошабинларда       инерсия ҳаракатини келтриб чиқарди.  

3. Саҳнабоплик. Томошабин персонажни тўғри идрок этишида уни 

ҳаракати, туриш ҳолатдаги мимика имо ишоралари муҳим рўл ўйнайди. Бу 

принсип театрнинг асосий қоидаси бўлиб ҳам ҳисобланди. Тасвирга олишда 

ҳар бир ана шу ҳаракат томошабин диққатига очиб берилиши лозим. 

4. “Калит кадрлар” . Бу принсип кадрни компановка жараёнини назарда 

тутади яЪни, расом  персонажни аниқ бир ҳолатда турагани чизади. олдиндан 

ржалаштрилган ҳамма ҳаракатлар ва натижалар ана шу ҳолатни ўйлашга олиб 

келади. Бу ҳолат унумдорликни оширади. Муаммо шундаки бундай 

ҳаракатдаги тасвирни яратишда рассомлардан катта меҳнатни талаб қилади. 

5. “Узлуксиз ҳаракат”. Бу принсип асосига кўра ҳаракат ҳеч қачон 

тўхташи керак эмас. Шундай элементлар мавжудки, мисол учун қулоқ, дум, 

кийим ва х.к улар доим ҳаракатда бўлмоғи лозим. Икки ёқлама ҳаракат 

деганда ушбу элементлар бир вақтдан иккинчисига узлуксиз ўтиб туради. 

Мисол учун қадам ташлаганда, югурганда ва х.к. прсонажнинг ҳаркатда 

бўлмаётган вақтда тана элементлаирнинг алоҳида ҳаракати узлуксиз ҳаракат 

дейилади. Узлуксиз харакат  даври алмашинувини таминлайди. Агар 

персонаж югура туриб тезда тохтаса, тананинг қисмлари ҳам тезда 

тохтамаслиги улар ҳали ҳаракатда бўлиши ва секинлик билан тохташи 

кераклигини ифодайди (соч, дум, қулоқ ва х.к). пиёда юрганда танани 

ҳаракати сон қисмидан бошланади кейин топиқ қисмга ўтади. Шу аснода 



танаани бошқа қисмлари занжир сифатида бир бирига бўғланади. 

Ҳаракатнинг бошланиши бошқа бир ҳаракатни юзага келтриб чиқариши 

анимацияда  икки ёқламали ҳаракат ёки узлуксиз ҳаркат дейилади. 

6. “ Айланма ҳаракат”. Ҳар бир трик мавжудот  ҳар доим айлана 

траеторияси бўйлаб ҳаракатланади. Шунинг учун анимацияда  тўғри чизиқ 

услуби қўлланилади бу меҳаник ҳаракат билан боглиқ бўлиб ҳудди робот 

ҳаракатига ўхшайди. Ҳаракат тректорияси тезликни қандай бўлиш қоидасини 

таминлайди. Агар персонаж ҳаракати тез бўлса, траектория текис бўлади, агар 

секин бўлса, траектория ҳам шунга яраша эгри бўлади. 

7. “Иккинчи даражали ҳаракат”.  Кўпинча песонажга ўзгача жило бериш 

учун  Иккинчи даражли ҳаракат ишлатилади. Масалан, Иккинчи даражали 

ҳаракат анимация дунёсини анча ривожлантирди. Иккинчи даржали ҳаракат 

персонажни ҳаётий ва эмоционал чиқишда ёрдам беради. 

8. Вақт ҳисоби. Бу принсип персонажни умумий ҳолатини кўрстади. Қай 

даражада томошбин бутун персонажга баҳо беради? Бутун персонаж бир 

фурсатда бирлаштриладики бунда тез ҳаракатдан секин ҳаракатга ўтказилади. 

Бунинг учун персонаж оз вазнига мос равишда ҳаракатда бўлиши, рассом вақт 

ҳисобини олиши ҳар бир персонаж захлеста ҳаракатини оча бериши лозим. 

Бунда қахрамонни эмоционал холатини, характер холатини вақт ҳисобини 

тўғри ташкил этиш лозим бўлади. Ҳаркатлангада сарф қилинадиган энерияни 

чарчоқ холатларини хаётий чиқишини талаб қилади. 

9. Бўрттириш.  Уолт Дисней ўз иш чларидан талаб қилардки тасвирни 

ҳаётий чиқишига ва “карикатурани ҳаётийлигига ”катта этибор берар эди. 

Агар персонаж ғамгин холда бўлса қоронғу зулматли, ҳурсанд бўлса ёруғ 

нурафшон бўлишини талаб қилган. Бўртириб акслантриш ёрдамида 

эммоционал ҳолатни томашабинга этказиб берган, аммо персонажни хул 

атворни ифодалашда карикатура жозибалигига боғлиқ бўлган. 

10.  Профессионал тасвир. Анимацияда тасвир муҳим рол ўйнайди.  

Дисней устудиясида кўплаб тахтачаларида турли ёзувлар бўларди масалан, 

“Сени тасвирий ижодини бошқалар хис қилиш учун унда теранлик ва 



мувозанат бўлиши керак ” дейилган. Профессионал тасвир принсипи тасвирни 

“эгизак” қилиб  чизишни такидлиди. “Эгизак” деганда ҳар қандай тасвирни 

иккинчи марта қайта тизилиши ёки симметрик бир ҳил бўлишликни 

англатади. Эгизаклар одатда камдан кам ҳолларда бибиидан фарқ қилишади. 

Ана шу принсип асосига кўра бир песонажни чизаёганда уни ҳар бир кадрни 

аввалгисидан ажралиб қолмаслиги учун рассомлардан катта маҳорат талаб 

қилади. 

11.  Жозибадорлик. Персонажни жозибадорлиги-филмни муваффақият 

йўлидир. Персонажни жозибадорлигини қандай аниқлаш мумкин? 

Жозибадорлик ҳар қандай жисмда бўлиши мумкин, агар мамнуният билан 

унга қарасангиз унда оддийликни, ёқимлийликни, яхши бир дизайни, 

хусункорликни, инсонни ўзига тортувчи бир хислатни туйишингиз мумкин. 

Бу персонажни жозибадорликдан  диққатни узуб бўлмайди. Хатто салбий 

қахрамон хам томашабин диққатни ушлаш учун. жозибадор бўлишликни 

талаб этади.  

 

1.5. Анимацион филмни яратиш босқичлари 

Анимацион филмларни яратишда компютер технологиярини тадбиқ 

қилиш билан биргаликда томошабин этиборини жалаб қилиш катта меҳнатни 

талаб этади. 

Ҳар қандай осон туйилган компютер анимацияси рассом, ёзувчи 

режиссиёрдан котта маҳоратни талаб этади. 

Биринчи босқич-Мавзуни ўйлаб топпиш ва ссенарийсни тузиш. 

Иккинчи босқич- персонажни яратиш ва уни ишалш стили ватехникасини 

танлаш. 

Учинчи босқич- филмни схемасини аниқлаштириш ва ҳарбир кадр вақтни 

аниқлаштириш. 

Тўртинчи босқичда  Қисқа сюжетларда персонажларнинг ҳаракати 

шакллантирилади.  



Бешинчи босқич- Адобе Премиер дастурида мусиқавий фон эффектарини 

бериш. 

 

Биринчи боб бўйича  хулоса 

Бу бобда анимацияни тарихий жараёнларини, анимацияда бўладиган 

ҳодиса, принциплари, технологиялари, анимацион филмларни босқичма- 

босқич ривожланиш билан танишилди. 

 

 

 



II БОБ. MACROMEDIA FLASH ДАСТУРИ ҲАҚИДА 

 

2.1. Adobe Flash дастури ҳакида асoсий тушунчaлaр 

Flash-технологияси қуйидагилардан ташкил топган: векторли графика; 

анимацияларнинг бир қанча кўринишини қўлланиши; интерактив элементлар 

интерфейсини яратиш имкони; синхрон овозларни ёзишни ўз ичига олиш 

имкони; Flash фильмларни, шунингдек, Интернетдаги исталган график 

форматларни HTML форматига ўтказишни таьминлайди;  

Adobe Flash дастури ёрдамида ҳам анимация ва такдимот файлларни 

яратишимиз мумкин. Аммо, Power Point га қараганда Adobe Flash дастурида 

яратилган анимация файллари тўлиқ сиз томонингиздан яратилади.  Шу билан 

биргаликда бу дастурда актив элементлар билан ишлаш ва дастурлаш 

имкониятлари мавжуд. Aсосан, Adobe Flash дастурида кичик анимация 

файллари (клиплар), Интернет саҳифалар, электрон қўлланмалар ва бошқа 

Flash дастурида яратилган файллар ўзининг оригиналлиги, ишлаш соддалиги, 

яратилиш мураккаблиги, тезкорлиги, мультимедия билан жиҳозланганлиги ва 

ҳажм бўйича кичиклиги билан кўзга ташланади. 

1. Кoмпютeрдa тасвирлaр икки xил усулдa тaйёрлaнaди вa сaқлaнaди: 

вeктoр вa растрли форматларда.  

a) Вeктoр тасвирлaр (инглизчa vector image; русчa - векторные 

изображения) - бундaй усулдa тасвир вeктoрнинг тeкисликдaги фoрмулaлaри 

oрқaли ҳoсил қилинaди. Бу турдaги фaйллaрдa шу вeктoрлaр фoрмулaлaри вa 

улaрнинг xусусиaтлaри (рaнг, узунлик вa ҳ.к.) сaқлaнaди. Бундaй фaйллaр:  

wmf (windows metafile); emf (enhanced metafile); cdr (Corel Draw standart 

fayllari);  ai (Adobe Illustrator standart fayllari) вa ҳ.к. 

б) Растр тасвирлaр (bitmap images; растровые изображения) - бундaй 

усулдa тасвир ушбу тасвирни ҳoсил қилувчи ҳaр бир нуқтaнинг xусусиятлaри 

(рaнги, кooрдинaтаси вa ҳ.к) oрқaли ҳoсил қилинaди. Бундaй фaйллaр: . bmp 

(bitmap); .pcx (paintbrush image); tiff (tagged image file фoрмaт); jpeg (joint 



photographic experts group - compressланган /сиқилгaн, ҳaжмaн қисқaртирилгaн 

/  растр тасвирлaр) вa ҳ.к. 

Вeктoр усулдaги тасвирлaр ҳaжмaн aнчa кичик бўлaди. Чунки ундa фaқaт 

вeктoрлaр фoрмулaлaри жoйлaштирилгaн. Бирoқ шу билaн биргa, вeктoр 

расмлaр кўpинчa сoддa, примитив (қўлдa чизилгaн қaҳрaмoнлaр, oбъeктлaр, 

мултиклaр вa ҳ.к) кўринишдa бўлaди. 

Растр тасвирлaр эсa бирмунчa ҳaётий (фoтoгрaфиялaр) кўринишдa 

бўлaди. Бирoқ улaр ҳaжмaн вeктoр тасвир фaйллaригa қaрaгaндa aнчa йирик 

бўлaди. Чунки улaрдa тасвирни тaшкил қилувчи ҳaр бир нуқтa (dot) ҳaқидa 

мaълумoт бўлaди. Дeмaкки, тасвир қaнчa кўп нуқтaгa эгa бўлсa, фaйл ҳaжми 

шунчaлик oртaди.  Расмдa нуқтaлaр сoни қaнчa кўп бўлсa у шунчaлик aниқ, 

дeтaллaштирилгaн бўлaди. Нуқтaлaр сoни oдaтдa дпи (Dot per Inch - бир 

дюмгa тўғри кeлaдигaн нуқтaлaр сoни) aтaмаси билaн бeрилaди. Масaлaн, 

стaндaрт мoнитoрингиз кўрсaтиши мумкин бўлгaн нуқтaлaр сoни 96 dpi. 

Шунингдeк 100x100, 640x480 вa ҳ.к. кўринишидa ҳaм бeрилиши мумкин. 

Бундa 1-сoн гoризoнтaл чизиқ бўйлaб жoйлaшгaн нуқтaлaр сoни, иккинчиси 

эсa вeртикaл чизиқ бўйлaб жoйлaшгaн нуқтaлaр сoнини билдирaди. Рус 

тилидa тасвирнинг грaфик кўрсaтиш имкoнияти разрешение (инглизчa 

рeсoлутиoн) дeб юритилaди.  

 

2.2. Adobe Flash дастурнинг асосий панеллари 

 Дастурнинг яна бир асосий иш сохалардан бири бу - иш куроллар 

тугмалар сохаси. У ёрдамида биз хар хил график шаклларни яратишимиз ва 

улар устидан хар хил амалларни бажаришимиз мумкин булади. Ушбу сохада 

иш курол тугмалари пастида чизиклар рангини ва орка рангини 

узгартириш сохалари, хамда танланган иш курол хусусиятларини созлаш 

сохаси жойлашган. Хар битта иш курол узининг имкониятларига, холатларига 

ва хусусиятларига эга. Масалан рангни шакл ичига беришда: тулик чекланган 

шакл, тулик чекланмаган шакл ва бутунлай чекланмаган шакл холатида 



ишлаш мумкин. Ушбу кушимча холатлар ва хусусиятлар тугма маъносидан 

кейин кавсларда курсатилган.  

 
Иш куроллар (ёрдамчи тугмалар) маъноси  

- V - Шакл ёки сохани танлаш ва уни кадр буйлаб харакатлантириш  

- A - Кадрда танланган шакл чегараларини узгартириш 

- N- Кадрга чизик турдаги шакл чизиш 

- L - Кадрда лассо ёрдамида ихтиёрий соха танлаш (сехирли таёкча ва 

купбурчак ласо холатлари хам мавжуд) 

- P - Кадрга купбурчак турдаги шакл чизиш 

- T - Кадрга матн элементини кушиш 

- O - Кадрга айлана турдаги шакл чизиш 

- R - Кадрга туртбурчак турдаги шакл чизиш (брчаклари айланасимон 

холати хам мавжуд) 



- Y - Кадрга калам ёрдамида шакл чизиш (чизилган шакл чегаралар турини 

узгартириш холати хам мавжуд) 

- B - Кадрга муйкалам ёрдамида шакл чизиш (чизиш тури, муйкалам 

калинлиги ва шаклини узгартириш холатлари хам мавжуд) 

- Q - Кадрда танланган шаклни чузиш (шаклни айлантириш, чузиш, 

кийшайтириш, чегараларини узгартириш холатлари хам мавжуд) 

- F - Кадрда танланган шакл рангларининг йуналишини узгартириш 

- S - Кадрда танланган шакл чегаралар рангини узгартириш 

- K - Кадрда танланган шакл орка рангини узгартириш (тулик чекланган 

шакл, тулик чекланмаган шакл ва бутунлай чекланмаган шакл орка рангини 

узгартириш холатлари хам мавжуд) 

- I - Кадрда ишлатилган рангни кайта танлаш 

- E - Кадрда ихтиёрий сохани учиргич ёрдамида учириш (чегара, орка ранг 

ва танланган ранг, учиргич калинлиги ва сехирли учиргич холатлари хам 

мавжуд) 

- H - Кадр сохасини силжитиш 

- Z - Кадрни маштабини узгартириш (катталаштириш ёки 

кичкиналаштириш холатлари хам мавжуд) 

чизиклар рангини ва орка рангини узгартириш сохаларини 

танлаганимизда куйидаги мулокот сохаси хосил килинади.  

        



       У ёрдамида ёки ранг коди оркали, ёки 256 рангдан танлаб, ёки спектрдан 

рангни танлаб олишимиз, хамда ранг бериш йулини танлашимиз мумкин. 

Рангни бошка йул билан хам узгартириш мумкин. Бунинг учун Окно 

менюсидаги Цветовой набор (Ctrl+F9) ва Цветовой микшер (Shift+F9) 

буйрукларни ишга туширамиз.  

 Ойнанинг унг томонида кадрни куриш масштабини узгартириш 

сохаси жойлашган. У ёрдамида тулик кадрни, тулик иш сохани, 

25%, 50%, 100%, 200%, 400% ва 800% куринишига утказиш 

мумкин.  

  Хар бир график шакл ва белги узининг хусусиятларига эга. Ушбу 

хусусиятлани экранга чикариш ва уларни узгартириш учун чап тугмаси билан 

танлаб Свойства (Proprties) ёки Ctrl+F3 ёки Окно менюсининг шу номли 

буйругини танламиз. Натижада шу номли мулокот ойнаси экранда хосил 

килинади ва у ёрдамида биз хар бир график шакл ва белгининг 

хусусиятларини узгартиришимиз мумкин булади.  

 
       Масалан, иш соханинг буш жойига босиб шу ойнада хосил килинган 

элементлар оркали иш соханинг хажмини, орка рангини ва кадрлар алмашиш 

тезлигини узгартиришимиз мумкин. Агар бошкарув кадр танланган булса, у 

холда анимация тури, унинг хусусиятлари, товуш билан жихозланиш ва 

хоказо холатларини узгартиришимиз мумкин. Агар матн элементи танланган 

булса, у холда матн харфлар шакли, катталиги, интерваллари, ранги, абзацда 

жойланиши ва хоказо шрифтга тегишли холатларни узгартириш имконияти 

пайдо булади. Агар эса график шакл танланган булса у холда унинг кадрда 

жойланиш координаталари, катталиги, чегара чизикларининг калинлиги ва 

ранги, улар тури ва шаклнинг орка (ички) рангини узгартириш имконияти 

пайдо булади.  



    Дастурни ишга тушириш учун Windows нинг ПУСК тугмасининг 

ПРОГРАММЫ булимининг Adobe грурухи ичидаги Adobe Flash буйругини 

танлаймиз. Натижада экранда куйидаги дастур ойнаси хосил килинади.  

 
       Flash дастурида ишлаш учун биз бир нечта янги тушунчалар билан 

танишимиз зарур. Булар: Flash белгиси, график тасвир (символ), анимацион 

клип, актив тугма, сцена, кадр, бошкарув кадр, вакт-чизгичи, ва катлам.  

 
       Вакт-чизгичи (TimeLine - Временная шкала) - Flash дастурида анимация 

харакатларни яратишида асосий иш куроли. Ушбу сохада катлам ва кадрларни 

кўришимиз ва улар устидан хар хил амалларни бажаришимиз мумкин. Вакт-

чизгич оркали катламларни жойлашуви ва тури, кадрлар тури (бошкарув ва 



автоматик яратилган кадрлар) ва улардаги action дастурлаш скриптлар 

мавжудлигини куришимиз ва созлашимиз мумкин.  

       Ушбу соханинг чап томонда катламлар сохаси, унг томонда эса шу 

катламлардаги кадрлар сохалари жойлашган.  

Вакт-чизгичнинг чап (катламлар) томони 

- устуни катлам куриниши ёки куринмаслигини,  

- устуни катламни узгартириш мумкинлиги ёки мумкин эмаслиги ва  

- устуни катлам элементлари тулик ёки факат чегаралари куринишини 

узгартиришга ёрдам беради. 

- тугмасаи янги катлам яратиш,  

- тугмаси харакат траекторияси катламни яратиш,  

- тугмаси катламлар учун папка яратиш,  

- тугмаси эса танланган катламни учириш амалларни бажаради.  

Вакт-чизгичнинг унг (кадрлар) томони 

Вакт-чизгичнининг унг томоннинг пастки кисмидаги жойлашган 

- сохаси бош кадрга утиш, кушни кадрларни ёки улар 

чегараларини курсатиш хамда бир нечта кадрларни бир пайтда тахрирлаш 

тугмалари, - сохаси эса нечанчи кадр танланган, кадрлар тезлиги 

ва нечанчи секундда жойланишимизни курсатувчи тугмалари.  

 
       Катлам (Layer - Слой) - хар бир график мухаррирларидек Flash дастурида 

хам катламлардан фойдаланамиз. Кайси катлам юкорида жойлашган булса шу 

катлам объектлар бошкалар устида курсатилади. Катламни куринмас ёки 

узгартирувчан эмас холатга утказиш мумкин. Катламлар оддий, харакат 

траектория катлами ёки маска (пайдо булиш) катлам куринишида булиши 

мумкин. Бир вактдаги бир нечта хар хил харакатлар учун хар хил катламлар 

керак.  

 - Кадр (Frames - Кадр) - Flash ва купкина анимацион мухаррирлар хамда 

видео монтаж дастурлар Асосида кадрлар кетма кетлиги жойлашган. Кадрни 



сиз узингиз чизиб яратишингиз ёки дастур уни узи автоматик яратиши 

мумкин. Кадрлар ичида бошкарув кадр (keyframes - ключевой кадр) 

тушунчаси мавжуд булиб, у харакат траекториясининг нукталарини 

белгилайди. Автоматик яратилган кадрлар эса икки хил булади: шакллар 

геометриясини узгариши (shape tweening) ёки бошкарув кадрлар узгариши 

(motion tweening) Асосида яратилган кадрлар .  

Кадрлар устидан бажариладиган асосий  амаллар. F7 ёки Вставка 

менюсида Вставить пустой ключевой кадр (Insert blank keyfrme) - актив 

катламда янги буш бошкарув кадр яратиш. F6 ёки Вставка менюсида 

Ключевой кадр (Insert keyframe) - актив катламда кейинги бошкарув кадрини 

яратиш Shift+F6 ёки Вставка менюсида Очистить ключевой кадр (Clear 

keyframe) - актив катламда танланган бошкарув кадрини тозалаш F5 ёки 

Вставка менюсида Кадр (Insert frame) - актив катламда буш кадрини яратиш 

Shift+F5 ёки Вставка менюсида Удалить кадр (Remove frames) - актив 

катламда танланган кадрини тозалаш. 

 
       Белгилар (Symbol - Символ) - Flash дастурнинг асосий  элементларидан 

бири. У оддий график ёки бир нечта катламдан иборат муракаб график тасвир 

(graphic), анимациялашган клип (movie clip) ёки актив тугма (button) 

куринишида булиши мумкин. Хар битта белги уз ичига бир нечта бошка 

белгиларни олиши мумкин булганлиги сабабли Flash дастурида ишлаш жуда 

кулай. Янги белги яратиш учун Ctrl+F8 ёки Вставка менюсида Новый символ 

(New symbol) буйригини танлаймиз. Натижада янги белгининг яратиш 

мулокот ойнаси чикади, ушбу ойнада биз белги турини (график тасвир - 

graphic, ёки актив тугма - button) танлаймиз ва ОК тугмасини босамиз. Янги 

белгини бошка йул билан хам яратиш мумкин. Агар бирор бир тасвир 

кисмини сичконча билан танлаб F8 ёки Вставка менюсида Преобразовать в 



символ (Convert to Symbol) буйригини танласангиз, у холда Flash шу тасвир 

асосида сиз танлаган турига мансуб янги белги яратади.  

Белгининг турлари. График тасвир (graphic) - битта кадрдар ва битта ёки бир 

нечта катламлардан иборат белги. Актив тугма (button) - туртта кадрдан (Up, 

Over, Down, Hit) ва битта ёки бир нечта катламлардан иборат белги. Up - 

тугма оддий куриниши, Over - сичконча курсори тугмага курсатиб турган 

куриниши, Down - сичконча курсори тугмага курсатиб босилиб тугран 

куриниши, Hit - тугма активлашиш соханинг куриниши. Анимациялашган 

клип (movie clip) - чекланмаган кадрдар ва катламлардан иборат белги. Ушбу 

белги уз ичига бир нечта бошка белгиларни (график тасвирлар, актив 

тугмалар ва бошка анимацион клипларни) олиши мумкин.  

       Белгилар кутубхонаси (Библиотека - Library) - 

хар хил турдаги белгилар билан ишлаш учун Flash 

нинг махсус ойнаси. Уни экранга чикариш учун 

Ctrl+L ёки F11 ёки Окно менюсининг Библиотека 

(Window Library) буйругини танлашимиз керак. 

Ушбу ойна оркали биз барча белгиларни 

куришимиз, уларни тахрирлашимиз, янги 

яратишимиз ва учиришимиз, хамда уларни 

кадрлар кушишимиз мумкин. 

Асосий ойна. Юқорида вақт шкаласи жойлашган. У кадрларни ўз ичига 

олади. Унинг чап томонида слойларни бошқариш панели жойлашган. Бу 

намунада икки sloy бор: «Background» (Фон) ва  «Fox» (Тулки). 

Роликингиздаги барча объектлар: grafik, movie clip, тугмаларни иш майдонида 

жойлаштиришингиз мумкин. Слойлар панелининг хусусиятларидан бири: 

Show/Hide (Показать/Скрыть) va Lock/Unlock (Заблокировать/Разблокировать) 

тугмаларидир. Bu tugmalar ёрдамида маълум слойни вақтинча 

"қимирламайдиган"(блокированный) қилиб қўйишингиз ёки умуман беркитиб 

қўйишингиз мумкин. Блокировка сизга бир слойда ўзгариш киритаётиб 

бошқасига тегиб кетмаслик учун хизмат қилади 



Панеллар. Color Mixer (Миксер стветов), Color Swatches (Образсты ствета) ва 

Components (Компоненты) панелларини ўз ичига олган ойна тасвирланган. 

Color Swatches панели бунда фойдаланиш учун очилган ҳолда турибди. Бу 

ойна 3та панелдан иборат. Сиз панеллар таркибини ўзгартиришингиз мумкин. 

Бу сичқонча билан кўтариб амалга оширилади. Панеллар ҳолатини эски 

бирламчи ҳолга қайтариш имкониҳар доим мавжуд: Window -> Panel Sets -> 

Default Layout (Окно -> Наборы панелей -> Расположение по умолчанию). 

Info paneli (Window -> Info) объектларни иш майдонида аниқ жойлаштириш 

учун керак бўлади. Объектни белгилаб олиб, сиз унинг координаталарини (X 

ваY), шунингдек, эни ва бўйини белгилаб олишингиз мумкин(W ва Н). 

Transform панели(Window -> Transform) эса, белгиланган объект масштабини 

ўзгартириш ва уни буриш имконини беради.  

Transfor панели. Энг кўп ишлатиладиган панеллардан яна бири -  Properties 

(Свойства)панелидир.Бу панел белгиланган объект ҳақида маълумот беради. 

Бу панел ёрдамида объект хусусиятларини ўзгартиришингиз мумкин. 

Масалан, Белгиланган кадрга белги қўйишингиз ёки символ нусхасига ном 

беришингиз мумкин. Клипларга дастурдан мурожаат этиш учун уларга ном 

бериш керак.  

Properties панели. Яна бир муҳим ойна бу Library (Библиотека) палитраси 

ҳисобланади. У ўз ичига растр тасвирлар, тугма, папка, гравик символ ва 

клипларни олади. Либрарй палитраси символларни бошқаришга имкон 

беради. Символар ҳақида кириш қисми постида ёзилган.  

Library палитраси. Меню пунктлари. Меню пунктлари жуда кўп ва 

турлича.Лекин уларнинг баъзларидан жуда кўп марта фойдаланишга тўғри 

келади. Ишимизни осонлаштириш учун "Иссиқ тугма"ларни ёдлаб олсак, ҳар 

доим Менюга мурожат қилиб ўтирмаймиз  

File Менюси. File Менюси ҳар бир дастурдагиФиле Менюсидагига ўхшаш 

пунктларга эга. Open (Открыть), Save (Сохранить) ваSave As (Сохранить как) 

буйруқларидан ташқари бу ерда Import (Импорт) тугмаси ҳам жой олган 

бўлиб, у ролигимизга растр тасвирлар, вектор графиклар ва овоз (мусиқа) 



файлларини импорт қилиш имконини беради. Шунингдек, File Менюсидан  

Publish (Публикастия) ваPublish Settings (Параметры публикастии) 

буйруқлари ҳам ўрин олган. Бу буйруқлар ҳақида кетйинроқ тўхталамиз.  

Edit Менюси. Edit (Правка) Менюси ҳам оддий буйруқлар: Сору 

(Копировать), Cut (Вырезать) ва  Paste (Вставить) кабиларни ўз ичига олади. 

Ундо буйруғи эса сизга охирги бажарилган 100та амални қайтариш имконини 

беради. View Менюси View (Вид) Менюси иш майдони кўринишини, унинг 

масштабини ўзгартиришда, шунингдек, тўр (сетка) ва ёъналтирувчилардан 

фойдаланишда ёрдам беради. Тўр  тезлик билан объектларни аниқ 

жойлаштириб олишга хизмат қилади. Grid (Сетка)ойнасини ҳосил қилиш учун  

View -> Grid -> Edit Grid (Вид -> Сетка -> Редактировать сетку)буйруғини 

танлаш керак. Бу ерда сиз тўрнинг масштаби ва унинг рангини танлашингиз 

ва у экранда кўрсатилиши ёки ёъқлиги ҳамда объектлар унга ёпишиши ёки 

ёъқлигини белгилаб олишингиз мумкин. 

Grid диалог ойнаси. View Менюсида Hide Panels (Скрыть панели)буйруғи 

ҳам бор. Бунда панеллар "беркиниб туради". Бу ишни Tab тугмасини босиш 

орқали ҳам қилиш мумкин.  

Insert Менюси. Insert (Вставка) Менюси AS дастурчиси учун фойдали2 

функцияга эга.  

1) Convert to Symbol (Преобразовать в символ) буйруғи. Бу буйруқ 

объектларни символ (movie clip, тугма, график)тарзида сақлашга имкон 

беради. 

2) кадрларни қўйиш, уларни бошқариш имконини берувчи буйруқлар: Insert -

> Frame (Вставить -> Кадр). Янги калит кадр қўйиш учун эса: Insert -> 

Keyframe (Вставить -> Ключевой кадр) и Insert -> Blank Keyframe (Вставить -> 

Пустой ключевой кадр). Бундан ташқари кадрларни ўчириш (Remove frame), 

Калит кадрни "тозалаш" (унинг ичидаги барча объектларни ўчириш)(Clear 

Keyframe) ва ҳ.к. буйруқлари мавжуд.. 

Modify менюси. Modify -> Document  Document Properties (Свойства 

документа) диалогли ойнасини чақиради, бунда сиз роликнинг бирқанча 



параметрларини ўзгартиришингиз мумкин. Document Properties dialogli oynasi. 

Transform (Трансформастия) буйруғига ҳам эътибор қаратиш лозим. Бу 

буйруқ ёрдамида иш майдонидаги объектлар масштаби, бурилиши ва 

транпозициясини ўзгартириш мумкин. Шунингдек,Group (Группировать) 

буйруғини ҳам эсга олиб ўтиш керак. Агар бир объектни иккинчисиниг устига 

олиб ўтсангиз, биринчи объектнинг беркитилган қисми ўчиб кетади. Бунинг 

олдини олиш учун, аввал объектни гуруҳлаб олсак, ўчиб кетмай, балки 

вақтинча беркиниб туради. 

Control менюси. Роликни вақти-вақти билан ёки финалда текшириш 

имконини берувчи буйруқлардан иборат. Test Movie (Пробное 

воспроизведение ролика) ёкиCtriҚEnter, роликни swfфайл кўринишига 

ўтказиб синаб олиш имконини беради. Play (Воспроизведение) буйруғи эса 

иш майдонининг ўзида анимацияни текшириб олишда асқотади. Play буйруғи 

берилганда AS кодлар ишламайди.  

Window менюси. Window (Окно) менюси ёрдамида ойна ва панеллар 

жойлашишини тартибга солишингиз ва ўзгартиришингиз мумкин 

Маълумот/Help (справкa) менюси  Бу менюдаги Flash help бўлими энг 

фойдали маълумотларни бериши мумкин. Ундан Flashда ишлаш ҳақида ва AS 

кодлари луғати ва уларни қўллаш ҳақидаги маълумотларни топса бўлади. 

Тугмалар ҳосил қилишКириш қисмида айтиб ўтилганидек, Flashда 3хил 

символ мавжуд: график объект, тугма ва клиплар. График объектлардан 

фарқли равишда, тугма ва клип символлари ActionScriptкодига эга бўлиши 

мумкин.   

Тугманинг вақт шкаласи. Тугма ҳосил қилиш усули: Insert -> New Symbol 

(Вставить -> Новый символ)ёки иш майдонида тугмага айлантиришни 

мўлжаллаган объектингизни белгилаб олиб, Insert -> Convert to Symbol 

(Вставить -> Преобразовать в символ)ни босасиз. Шунингдек, Library 

палитрасида қалқиб чиқувчи Менюдан New Symbol буйруғи орқали ҳам тугма 

ҳосил қилишингиз мумкин. Тугма ҳосил қилгач, устида сичқонча тугмасини 

икки марта босиб, ёки Library палитрасида шу тугма символи пиктограммаси 



устида босиб, тугмамизни таҳрирлашимиз мумкин. Иккала ҳолда ҳам тугма 

учун махсус (асосий вақт шкаласидан мустақил бўлган) вақт шкаласи. пайдо 

бўлади ва унинг юқори қисмида Up, Down, Over ва Hit бўлимчаларини 

кўришингиз мумкин.  

Тугма ичига хоҳлаганингизча слой қўшишингиз мумкин. Тугманинг вақт 

шкаласи Бу бўлимчалар нимага мўлжалланган:  

• Up - тугманинг одатий ҳолати;  

• Over - сичқонча курсори тугма устига олиб келинганда тугма эгаллайдиган 

кўриниш; 

• Down - фойдаланувчи тугмани босган, аммо ҳали қўйиб юбормагандаги 

кўриниши; 

• Hit - курсорга реаксия билдирувчи соҳани белгилаб беради.  

Аввалига Up кўриниши учун кадр ясаб олишга ҳаракат қилиш лозим. Кейин 

Over ва Down вариантлари учун кўриниш ясаш керак. Over кўринишида тугма 

бироз ажралиб туриши лозим, Down кўринишида эса уни босилган ҳолда 

кўрсатиш лозим. Унгача Window>Common Libraries> Buttonsни танлаб, Flash 

намуна тугмаларини иш майдонига олишингиз ва уларни очиб, таркиби ва 

дизайнини кўриб чиқишингиз мумкин. 

Фақат Up кадридан иборат тугма ҳосил қилишингиз мумкин.Агар қолган 

кадрлар бўш бўлса ҳам, Up кадри тугманинг барча ҳолати учун қўлланади.  

Hit кадрининг хусусияти шундаки, у ҳеч қачон кўринмайди. Шунингдек, Hit 

кадрида жойлашган объект ранги ҳам аҳамиятга эга эмас; фақат унинг шакли 

муҳим. Hit кадрини Over ва Down кадрлари каби умуман бўш қолдирса ҳам 

бўлади. Бунда Up кадридаги шакл унинг ўрнига ҳам ўтади. 

Hit кадри фақатгина тугмани босиш мумкин бўлган майдонни аниқлаб олиш 

учун қўлланади. Унинг ҳажми тугма график тасвирининг ўзидан катта 

бўлиши ҳам мумкин. Сиз Up, Over ва Down кадрларини бўш қолдириб, Hit га 

эса қандайдир шакл қўйиб, кўринмас тугма ҳосил қилишингиз мумкин. Бунда 

тугмангиз Flash бош ойнасида оч-ҳаворанг кўринишда бўлади. Ролик ижро 

этилаётганда эса, у умуман кўринмайди. Шунга қарамай тугмани босиш 



мумкин ва бунда унга бириктирилган AS код ишлаб кетади. Фойдаланувчи 

унинг тугма эканлигини англаб етади, чунки сичқонча курсори ўша соҳа 

устига борганда махсус кўринишга ўтади.  

Матн ҳосил қилиш. Flashда матнларнинг  

- Статик матн,  

- Динамик матн ва  

- Таҳрирланувчи матн. 

Статик матннинг AS программист учун унчалик аҳамияти йўқ, чунки bу 

оддий матн бўлиб, ролик ижро этилаётганда худди график тасвир 

функцияларини бажаради. Билишимиз лозим бўлган асосий матн турлари бу 

Динамик ва Таҳрирланувчи матнлардир.  

Матн хусусиятлари. Матн майдони белгиланганда Properties ойнаси 

матнимиз хусусиятларини кўрсатиб туради.Static Text тури белгиланган; сиз 

уни бемалол Dynamic Text ёки Input Textтурига ўтказишингиз мумкин.  

Матн  Properies ойнаси. Динамик матн (Dinamic Text) Dynamic Textматн 

турини белгиласангиз, Properties ойнаси ташқи кўриниши бутунлай ўзгаради. 

Динамик матн Properties ойнаси.Пастга очилувчи Менюдан матннинг бир 

қатор (Single Line), бир неча қатор (Multiline) ва текстни пастда давом 

эттириш имкониятисиз кўп қатор (Multiline No Wrap) кўринишида 

жойлаштирилиши кўрсатилади. Бундан ташқари ўнг томонда Selectable 

(Матннибелгилаш), Render Text as HTML (HTML тегларни тушуниш ва 

бажариш) ва Show Border Around (матн атрофида рамка ҳосил қилиш) 

опсиялари мавжуд. ActionScript тили учун энг муҳими бу ерда Var 

(Ўзгарувчи) ойначасидир.Унда сиз ўзгарувчи номини киритишингиз мумкин. 

Бу  ўзгарувчига AS код орқали мурожаат қилишингиз мумкин, демакки 

динамик матнни ролик ижроси пайтида ўзгартиришингиз мумкин. Properties 

ойнасидаги қолган тугмалар матн кўринишига жавоб беради. Бундан ташқари 

матнда ишлатилаётган шрифтингиз бошқаларда бўлмаслиги мумкинлигига 

кўзингиз етса, шу шрифтни роликка қўшиш имконини берувчи ойнача ҳам 

мавжуд.. 



Таҳрирланувчи матн (Input Text). Матннинг 3-тури бу Input Text 

(таҳрирланувчи матн). Бундай матн ойнасига ролик ижроси давомида 

фойдаланувчи матн киритиши ватаҳрирлаши мумкин. Properties ойнаси бу 

матн турида деярли фарққилмайди. Input Text матни учун Single Line, 

Multiline ва Multiline No Wrap кўринишлари билан бирга - Password (Парол) 

кўриниши таклифқилинади. Шунингдек, Max Chars (Киритиш мумкин бўлган 

белгиларнинг максимал сони) параметри орқали фойдаланувчи ушбу матн 

майдонига энг кўпи билан қанча белги киритишини белгилаб қўйиш мумкин 

(0 қўйилса, белгилар сони чекланмайди).  

Flashга мултимедиа элементларини импорт қилиш Flash асосан вектор 

тасвир учун мўлжалланган бўлса-да, унда бошқа элементлар, масалан, растр 

тасвирлар ва овоз файлларини ишлатиш мумкин. Flash уларни таҳрирлаш 

имконини бермайди, бу элементлар фақатгина ролик билан бирга ижро 

этилади холос.  

Растр тасвирлар. File -> Import (Файл -> Импорт) буйруғи орақли растр 

тасвирни импортқилишингиз мумкин.Сиз турли форматлар: JPEG, GIF, PICT 

ва BMPкабиларни импорт қилишингиз мумкин. Импорт қилинган файл 

ролигингиз библиотекасига қўшилади. Уни клипингизга ҳам қўшиб 

олишингиз мумкин.  Bitmap Properties (Растр тасвир хусусиятлари) ойнаси 

кўрсатилган, уни библиотекадаги расм символи пиктограммасида сичқонча 

тугмасини икки марта босиб чақиришингиз мумкин.  

Bitmap Properties ойнаси. Растрни векторга айлантириш учун Modify -> 

Trace Bitmap (Изменить -> Трассировать растр).Бунда диалог ойнаси пайдо 

бўлади. 

Trace Bitmap диалог ойнаси.Трассаланган расм аввалги расмдан сифат 

жиҳатдан анча фарқ қилиши мумкин, бироқ энди бу вектор тасвир ва унинг 

устида баъзи амалларни бажариш мумкин. Трассалаш, яъни растрни векторга 

айлантиришда кўпчилик professional рассомлар Adobe Streamline, Corel Trace 

каби дастурлардан фойдаландилар. Кейин натижани Flashга импорт 

қиладилар. 



Овозлар Улар ҳам худди растр тасвирлар каби импорт қилинади. Қуйидаги 

овоз файлларини импорт қилиш мумкин: AIFF, МРЗ, Sun AU va Wave. 

Импорт қилгач, библиотекадаги овоз символи пиктограммасида сичқонча 

тугмасини икки марта босиб Sound Properties (Свойства звука) диалог 

ойнасини чақиришингиз мумкин.  

Sound Properties диалог ойнаси. Одатда овоз элементлари вақт шкаласидаги 

калит кадрга қўйилади. Ролик ижро этилаётганда шу калит кадр билан бирга 

овоз файли ҳам ижро этилади.  

Роликни ташкил этиш жараёни.  Ташкилий масалалар  AS дастурчи учун 

роликни ташкил қилиш жараёни жуда муҳим.  Бунда қуйидаги элементларга 

эътибор бериш лозим:  

Библиотека. Библиотекадаги символларга маъноли ном берилиши лозим. 

Керак бўлганда уларни каталоглар бўйича жойлаштириш керак. Ўхшаш 

функцияли символларни, албатта, битта каталогга бирлаштириш мақсадга 

мувофиқ. Бунинг uchun Biblioteka (Library) ойнасида керак бўлган 

символларни белгилаб туриб сичқонча ўнг тугмасини босамиз ва Move to new 

folder амалини бажарамиз. Бунда Янги папка номини киритиш керак. Агар 

уларни мавжуд папкага кўчирмоқчи бўлсангиз, белгилаб туриб кўтариб 

ўтказишингиз кифоя. Янги папка очиш учун эса, Library ойнасида юқори ўнг 

бурчакни босганда очиладиган Менюдан New Folder (Новая папка)буйруғини 

танлаш керак. Library палитраси ва унда очилган папка.    

Кадрлар. Кадрларга белги (марк) қўйиш эса ролик ижро этилаётганда 

навбатдаги кадрга эмас, балки AS кодда кўрсатилган кадрга ўтиш имконини 

беради. Кадрларга Properties панелида белги қўйилади. 

ASда, шунингдек, кадр тартиб рақами (номери)га ҳам ўтишни буюриш 

мумкин. Бироқ бу мақсадга мувофиқ эмас. Чунки иш жараёнида, янги кадр 

қўшсангиз, ёки борини олиб ташласангиз, кодда кўрсатилган тартиб 

рақамларни ҳам мос равишда ўзгартиришингиз керак бўлади. Масалан, AS 

код орқали 7-кадрга ўтиш буюрилган бўлса, ва кейинчалик бу кадрдан 

олдинга яна 2 та кадр қўшилса, у ҳолда коддаги 7 рақамини 9 га ўзгартириш 



керак бўлади. Агар кодда бу рақам бир неча бор кўрсатилган бўлса, у ҳолда 

қийинчилик туғилиши табиий.  Кадрга белги қўйиб, AS кодда шу белгига 

мурожаат қилиш мумкин.  

Sloyлар (қатламлар)  Sloyлар билан ишлашда ҳам тартибга риоя этиш лозим. 

Бунда орқа ва олдинги планлар, қайси символ ёки график қайси Sloyда 

туриши кераклигини аниқлаб олиш керак бўлади.  

Саҳналар. Саҳналар одатда кўп ишлатилавермайди. Бироқ мураккаб 

роликларда улардан фойдаланиш мумкин. Улар худди алоҳида флаш 

роликларни бирлаштиришдан ҳосилбўлган натижани бериши мукин. AS код 

ёрдамида Саҳнадан саҳнага ўтишни назорат қилиш ва тартибга солиш мумкин 

(худди кадрлар каби).  

Иш майдонидан ташқари майдон. Бу майдондан қоралама сифатида 

фойдаланиш мумкин. Бундан ташқари бу майдонда жойлаштирилган 

символга илинган AS код иш майдонидагидан фарқли ўлароқ, битта кадрда 

эмас роликнинг барча кадрларида бажарилади. Бу хусусият баъзи ҳолларда 

жуда қўл келиши мумкин. Роликни публикатцияга тайёрлаш.  Роликингиз 

оддий анимация ёки мураккаб дастур бўладими, бундан қатъиназар, тайёр 

бўлгач, уни svf файлга экспорт қилиш керак бўлади: File -> Publish (Файл -> 

Опубликовать). Бироқ сал аввал ундаги баъзи элементларни текшириш ва 

баъзи параметрларни созлаб олиш лозим. Мана бу текширилиши керак бўлган 

элементлар рўйхати:  

• клип нусхаларининг номлари - иш майдонидаги клиплар нусхаларининг 

номи AS кодda ko'rsatilгаn nomlarга mos bo'lishi kerak; 

• агар клип нусхаси иш майдонида бўлмаса, лекин AS код орқали клипнинг 

ўзига мурожаат этилган бўлса, у ҳолда библиотекада уни клип билан бирга 

экспорт қилинадиган қилиб созлаб қўйиш керак. Бу овоз файлларига ҳам 

тегишли;  

• динамик матн номи - динамик матн номи ва унинг ўзгарувчиси AS кодга мос 

бўлиши керак; 



• ноёб шрифтлардан фойдаланган бўлсангиз, уларни роликка қўшиш эсдан 

чиқмасин; 

• stop буйруғи- ASнинг stop буйруғи интерактивлик қўлланилган барча 

кадрларда бўлиши лозим. Агар бу буйруқ бўлмаса, у ҳолда бу кадр оддий 

анимациянинг бир бўлагига айланади. Бу роликдаги клипларга ҳам тегишли. 

Агар улар AS орқали бошқариладиган бўлса, у ҳолда 1-кадрига  stop буйруғи 

илиниши лозим.  

Trace буйруғи – Flashнинг ички функцияси. Думалоқ қавслар ичида функция 

параметри кўрсатилади. Параметрлар - функциялар бажарилиши учун керакли 

маълумот. Trace функцияси битта параметрга ега: у ҳам бўлса, Output 

ойнасига жойлашадиган матнли қатор. Баъзи функциялар 1 ёки бир нечта 

параметрга эга бўлиши, баъзилари эса умуман параметрга эга бўлмаслиги 

мумкин.  

Ekraningizda ifodalanгаn tasvir paydo bo'lishi kerak. Actions ойнасини 

очганингизда юқори қисмида Actions – Frame сарлавҳасини кўрдингизми? У  

AS код ҳозирда танланган кадрга тегишли эканини билдиради.   

Биринчи ва ягона кадрга илинган дастур. Control -> Test Movie (Контроль -

> Запустить пробное воспроизведение ролика) амалини бажаринг. Бунда Flash 

swf-file ҳосил қилади ва уни prevyu (аввалдан кўриб олиш / предварительный 

просмотр) учун очади. Бўш ойна ҳосил бўлади. Чунки сиз роликка ҳеч қандай 

график, матн ёки бошқа элемент қўшганингиз ёъқ. Бироқ "Hello World!" output 

ойнаси ҳам ўша заҳоти пайдо бўлади. "Hello world" - 1-дастурингиз натижаси 

"Hello World" дастурини яратиш дастурлашни ўрганишни бошлаётганда 

биринчи босқич вазифасини ўташи аллақачон анъанага кириб улгурган. Зеро 

ўша Basic, Pascal, Java, C++ёки бошқа дастурлаш тили бўладими, барчасини 

ўрганиш айнан шу дастурдан бошланади. 

 Ролик ижроси устидан назорат. AS нинг goto And Play буйруғи билан аввал 

танишган эдик. Бу буйруқ кадрларни кетма-кет эмас, сиз хоҳлаган тартибда 

ижро этиш имконини беради. Демак, бу буйруқ орқали ролик ижросини 

бошқариш мумкин бўлади. 



Янги Flash-ролик ҳосил қилинг. 4та калит кадр ҳосил қилиб, уларни мос 

равишда  "part1" ... "part4" каби номланг. Бу кадрлар анимациямизнинг 4 

қисми бўлади. Бундан ташқари кадрларнинг ҳар бирига фойдаланувчига ҳозир 

экранда роликнинг қайси қисмини томоша қилаётгани ҳақида маълумот 

берувчи статик матн жойлаштириш керак.  Кадрларга мос равишда "PART 1"  

"PART 4" матнидан иборат статикматнларни жойлаштирамиз. "PART 1" 

матни"part1"калит кадрида, "PART 2" матни "part2"калит кадрида ва ш.к. 

бўлсин. Калит кадрлар орасида бир нечта кадр жойлаштиринг (Вақт 

шкаласида калит кадримизнинг белгиси тўлиқ кўриниб туриши учун) 4 

белгидан иборат вақт шкаласи тасвирланган. Расмда иккинчи калит кадр 

белгиланган, шунинг учун иш майдонида "PART 2" матни кўриниб турибди. 

Иккинчи калит кадрни белгиланг ва Actions ойнасини очинг. Ойнада қуйидаги 

буйруқни киритинг: goto And Play ("part4"); Note: AS код қўшилган кадр вақт 

шкаласида "а" белгисига эга бўлади. 4 калит кадрли ролик. Иккинчи калит 

кадр фаол турибди..Бу роликдаги ягона AS код.Ижро вақтида ролик "парт 1" 

кадридан бошланади, экранда "PART 1" матни ҳосил бўлади. Кейин вақт 

шкаласибўйича ижро этилиб, "part2"гача боради. Лекин "part2" кадридаги 

"PART 2" матни экран юзини кўрмайди, сабаби: ҳали матн чиқиб улгурмасдан 

кадрга илинган  AS код ижрони "part 4"га томон  буриб юборади ва "PART 4" 

матни ҳосил бўлади. Агар loop бегилси қўйилган бўлса, шу ҳол чексиз давом 

этади. 

AS код орқали "part 2", "part 3" кадрлари ижро вақтида "четлаб ўтилди". Сиз  

AS ёрдамида кадрлар ижроси кетма-кетлигини "бузишга"муваффақ 

бўлдингиз   

 Flashда тугмалар. Фойдаланувчи иштирокисиз AS ёрдамида роликни 

бошқаришни кўриб чиққандик. Келинг, энди роликка тугмалар қўшамиз: 

фойдаланувчи уларни босиб, роликнинг у ёки бу қисмига ўта олсин. Биринчи 

кадрга Код:Stop буруғини "илиш" орқали аниматцияни биринчи кадрда 

тўхтатиб қўйиш мумкин. Fayl ҳосил қилиб, кадрларга аввалги мисолдагидек 

ном беринг. Энди тугмани ўзингиз хоҳлагандек чизиб олинг ва иш майдонига 



жойлаштиринг (Тугмани чизиб олгандан сўнг уни ҳақиқий тугмага 

айлантириш учун уни белгилаб олинг, ва F8ни босинг, Button ни танлаб ok ни 

босинг. Шунда оддий расмимиз тугма символига айланади ва библиотекадан 

жой олади). Бизнинг мисолда тугма оддий ҳалқачадан иборат. Кейинги қадам 

- бир кадрдан иборат янги слой ҳосил қилиш. Бу слойга библиотекадан айни 

бир тугманинг 4 нусхасини жойлаштиринг. Натижа кўрсатилган. Икки 

слойдан иборат ролик. Биринчи слой 4 қисмдан иборат, ҳар бир қисм битта 

кадр. Иккинчи слойда эса битта калит кадр мавжуд. Бу ролик биринчи кадрига 

ҳам Код:stopбуйруғини илинг. Экран қуйи қисмида 4 тугма жойлашган. 

Биринчи тугмага "илинган" AS код расмда ҳам кўрсатилган: Код:on 

(press){goto And Stop("part1");} 

Тугмага нисбатан қандайдир ҳаракат билдирилганда унинг "ўзини тутиши" 

дастурий бажарувчи томонидан амалга оширилади. Бизнинг мисолда бу 

ҳаракат: Код: press Код:On синтактик элементи дастурий бажарувчи ишга 

тушганини англатади. Фигурали қавслар ичида реакция буйруқлари берилади. 

Бизнинг мисолда бу Код:goto And Stop буйруғи. Бу буруқ бирор кадрга ўтиш 

ва ўша кадрда тўхташ учун ишлатилади. Худди шу каби сценарийлар бошқа 

тугмаларга ҳам илинган. Фарқи: уларда мос равишда "part 2", "part 3" ва  "part 

4" кадрларига ўтиш буюрилади. Энди файлни текшириб кўринг. Қайси 

тугмани боссангиз, шу кадрга ўтилиши лозим. Бу мисол Flashнинг оддий 

анимация доирасидан чиқиб, интерактивликни ҳам қамраб олишини намойиш 

қила олади  

 

2.3  Adobe Flash дастурида анимация яратиш 

 

 Flash дастурида анимация икки хил булади: кадрли (покадровое создание) ва 

автоматик(автоматическое создание промежуточных кадров). Автоматик 

анимация шакллар геометриясини узгариши (shape tweening) ёки бошкарув 

кадрлар узгариши (motion tweening) асосидаги анимация турларга булинади.  

Бошкарув кадрлар узгариши (motion tweening) асосидаги яратилган анимация.  



       Шу турдаги анимацияни яратиш учун биз битта бошкарув кадрни 

яратамиз ва унга белги кушамиз. Масалан бошкарув кадрда айлана чизилади 

ва у график тасвир белги турига F8 ёки Вставка менюсида Преобразовать в 

символ (Convert to Symbol) буйриги ёрдамида утказилади. Ёки Ctrl+F8 ёки 

Вставка менюсида Новый символ (New symbol) буйригини танлаб янги белги 

яратамиз ва Белгилар кутубхонаси ёрдамида уни бошкарув кадрга кушамиз.  

 

          
 

       Энди белги жойлашган бошкарув кадрни сичкончанинг унг томондаги 

тугма ёрдамида танлаб Creat motion tweening ёки Вставить менюсининг шу 

номли буйругини танламиз. Шу харакатлар натижасида бошкарув кадр ранги 

кук рангга узгаради. Энди сичконча билан янги кадрни танлаймиз, (масалан 

25-чи кадрни) ва F6 ёки Вставка менюсида Ключевой кадр (Insert keyframe) 

актив катламда кейинги бошкарув кадрини яратиш буйругини танлаймиз. 

Натижада 25-чи кадрда кук рангли бошкарув кадр хосил килинади ва шу 

кадргача биринчи бошкарув кадрдан стрелка хосил килинади. Биринчи 

бошкариш кадрдан иккинчи бошкариш кадргача кадрлар кук рангда 

автоматик хосил килинади. Охирги харакатимиз - бу иккинчи бошкариш 

кадрдаги белгини узгартириш (чузиш, айлантириш, катталаштириш, 

кичкиналаштириш ёки кадрдаги жойланишини узгартириш). Энди 

клавиатурадаги Enter тугмасини босамиз ва биз яратган анимацияни 

куришимиз мумкин.  



Шакллар геометриясини узгариши (shape tweening)Асосидаги яратилган 

анимация.  

 Шу турдаги анимацияни яратиш учун биз бошкарув кадрлар 

узгариши (motion tweening) Асосидаги яратилган анимация хосил 

киламиз. Факат энди охирида иккинчи катламдаги белгини 

бутунлай учириб унинг урнига квадрат чизамиз. Шу харакатимиздан кейин 

кадрлар ранги нормал рангга кайтади. Кейин биринчи ва иккинчи бошкарув 

кадрлардаги график тасвир белгини Ctrl+B ёки Изменить менюсидаги 

Разделить отдельно (Breack appartack) буйруги ёрдамида алохида шаклларга 

булиб чикамиз. 

       Энди аввал биринчи бошкарув сичконча чап тугмаси билан танлаб 

Свойства (Proprties) ёки Ctrl+F3 ёки Окно менюсининг шу номли буйругини 

танламиз. Натижада мулокот ойнаси хосил килинади ва унда Tweening 

сохасида Motions урнига Shape холатини танлаймиз. Шу натижасида 

бошкарув кадр ранги яшил рангга узгаради. Энди иикинчи бошкару кадрни 

хам сичконча билан танлаб анимация турини Motions дан Shape га 

узгартирамиз ва охирида клавиатурадаги Enter тугмасини босамиз ва биз 

яратган анимацияни куришимиз мумкин.         Куришимиз мумкин иккала 

анимацияларда хам иккита бошкариш кадрлар уртасидаги масофа кадрларни 

компьютер узи автоматик яратган ва анимация тугри чизик буйича 

харакатланяпти.  

Аммо агар бизга харакат траектория 

буйича бажарилиши керак булса, у 

холда нима килиш керак? Бундай 

анимацияларни хосил килиш учун 

бизнинг катламимиз устида махсус 

харакат траектория катламини яратиш 

керак булади. Ва шу катламда калам 

билан кийшик траектория чизигини чизамиз. Натижани куриш учун 

клавиатурадаги Enter тугмасини босамиз.  



 

       Шу билан бирга автоматик 

анимацияларда фойдаланиш мумкин 

булган яна бир эффект мавжуд - бу 

маска катлами. Маска катламини учун 

Асосий  катлам устида янги буш катлам 

яратамиз. Шу катламни сичкончанинг 

чап тугмаси билан босиб Маска - MASК 

буйругини танлаймиз. Натижада катлам кук рангга узгаради ва иккала 

катламлар узгаришлардан химояланади. Маска катламдан шу химояни 

учириб, бошкарув кадрда бир нечта туртбурчаклар чизамиз. Кейин яна маска 

катламнинг химоясини ёкиб клавиатурадаги Enter тугмасини босамиз ва 

натижани курамиз.  

       Маска катламдаги бошкарув кадрни motion tweening анимациялаштирилса 

харакатланиш эфекти янада чиройли булади.  

 

2.4. ActionScript ёрдамида анимация 

Adobe Flash бу aнимaция, интeрaктив aмaлий дастур ярaтиш имкoнини 

бeрувчи дастурдир. Унинг ёрдaмидa кичик мултфилмлaр, интeрaктив 

oткрyткaлaр, тeст, виктoринaлaр вa aлбaттa, ўйинлaр ярaтиш мумкин. 

ActionScript эсa бу дaтсургa бириктирилгaн вa ундa фoйдaлaнилaдигaн 

(интeрaктивлик ayни шу тил ёрдaмидa ҳoсил қилинaди) дастурлaш тилидир. 

Бaъзи xусусиятлaри билaн Webда кэнг қўллaнaдигaн JavAScript тилини 

эслaтaди. 

Flash асосан вeктoр тасвирлaр билaн ишлaйди, лeкин кeрaк бўлгaндa унгa 

растр тасвирлaрни ҳaм жoйлaштириш мумкин. 

ActionScript бу Adobe Flash дастуридa фoйдaлaнилaдигaн дастурлaш тили 

ҳисoблaнaди. Ундaн фoйдaлaниш сизгa филмлaрингиздa интeрaктивликни 

қўллaш имкoниятини бeрaди. Усиз Flash оддий Gif aнимaтoрлaрдaн фaрқ 

қилмасди.  



ActionScript дa (AS yoзилгaн дастурни ижoзaтингиз билaн кeйинчaлик 

сценарий дeб aтaймиз (script - сценарий) 

AS сценарийлaри қayeргa қўйилaди?? 

a) Сценарийни Keyframe гa илиш мумкин. (Keyframeни бeлгилaб, F9 

тугмасини бoссaгиз AS paнeли oчилaди, мaрҳaмaт ) Филм ижрo eтилиш 

жaрaёнидa шу кaдргa кeлгaн зaҳoти унгa илингaн сценарий ишгa тушaди. 

Кaдргa илингaн сценарий икки турдaги eлeмeнтдaн тaшкил тopгaн бўлиши 

мумкин: 

  1 - оддий буйруқ (команда)лaр тўплaми; 

  2 - функсия - бу сценарий дaвoмидa, умумaн, филм дaвoмидa кўп мaртa 

ишлaтилиши мумкин бўлгaн кoдлaр тўpлaми. Уни xoҳлaгaн вaқтдa мaълум 

буйруқ  ёрдaмидa янa ишлaтиш мумкин. 

   б) Сценарийни тугмa (кнопка)гa илиш мумкин.  

Бундa сценарий шу кнoпкa бoсилгaндa (ёки қўйиб юбoрилгaндa, устидaн 

курсoр ўтгaндa вa ҳ.к.) ишгa тушaди вa мaълум aмaлни бaжaрaди. 

   c) Сценарийни movie-clip гa илиш мумкин.  

Бундa шу movie-clip дa бирoр ҳoдисa (событие) юз бeргaндa (бу ҳaқдa 

кeйинрoқ) сценарий ишгa тушaди. 

Шулaр бoшлaнишигa зaрур бўлгaн aтaмaлaр. Айнан шулaрни қўллaб 

тўлaқoнли Флaш ўйин, oткриткa, тeст вa бoшқaлaр ёки оддий мултиклaр ясaш 

мумкин. 

AS ёрдамида анимация. Энди Action Script (AS) ёрдамида предметларни иш 

майдони бўйлаб ҳаракатлантиришни ўрганамиз. Янги ролик ҳосил қилинг. 

Клипни иш майдонига жойлаштиринг. Бизнинг мисолда иш майдонида 

тулкининг расми жойлаштирилган. Агар хоҳласангиз, соддароқ бирор шакл, 

масалан, доира чизиб олинг ва уни клип символига айлантиринг. 

Ролик клип ва унга бириктирилган сценарийдан иборат Ушбу ҳолда  on Ciip 

Event ижро этиладиган бўлса, бу ҳодиса сценарийни қайта ишлаш дастурига 

секундига 12 маротаба юборилади. Агар ролик stop буйруғи билан тўхтатилса, 



ёки фақат биргина кадрдан иборат бўлса, у ҳолда ушбу кадр "сиклланиб 

қолади" (такрорланиб туради), яъни ролик тезлигида қайта чизилиб туради.  

Тугмалар учун хос бўлган On (press) сценарийси сингари, on Clip Event (enter 

Frame) ҳодисаларига реаксия буйруқлари ҳам шаклдор қавс ичига олинади. 

Бизнинг дастуримизда биргина буйруқ бўлади - у ҳам бўлса, клипни 1 пиксел 

чапга суриш буйруғи.  

Келинг сценарийни кўриб чиқамиз.  

Код:On Clip Event (enter Frame) { this._ x -- ;} This._х --буйруғи,  

This буйруғи ўзи тегишли бўлган объектга (бизда шу сценарийни ўз ичига 

олган клипга) мурожатни билдиради. This буйруғидан сўнг нуқта келади, 

нуқта объект хусусиятига мурожатни билдиради. Бизнинг мисолдаги _х 

клипнинг горизонтал ҳолатини билдиради. Шундай қилиб, this._х клипнинг 

горизонтал ҳолатини билдиради. -- символи декремент (қийматнинг 

камайиши буйруғи). У ўзидан олдин келган қийматни  1бирлик пасайтиради. 

Демак, this._x -- буйруғи аввал клипнинг горизонтал ҳолати (абсиссаси) 

қийматини олади,сўнг уни 1 бирлик пасайтиради.Агар клипни 1 бирлик ўнгга 

суриш керак бўлса, ++ (inkrement -қийматни кўпайтириш) буйруғидан 

фойдаланилади. Агар клипни 1 бирлик эмас, бир неча бирликка сурмоқчи 

бўлсангиз,++ ёки -+ буйруқларидан фойдаланасиз: Код:On Clip Event (enter 

Frame) {this._x -+ 5;}Бу буйруқ клипни беш пиксел суради.  

Flashда Scene (Sahna), Layer (Qatlam, Слой) ва Frame (Kadr) бу уч соҳа   

Flashда филм ярaтишингиздa асосий иш жoйлaри вa қурoллaри ҳисoблaнaди. 

a) Scene - кaм ишлaтилaди. Асосан бир мaвзугa oид сaҳнaдaн иккинчисигa 

ўтишдa қўллaнaди. 

б) Layer - бу энг кeрaкли қурoллaрдaн биридир. Layer бу сaҳнaдa жoйлaшгaн 

қaтлaмлaрдир. Масалан энг oрқa қaтлaмгa сиз фoнни (тaбиaт мaнзaраси, бир 

тoнли рaнг, рaдиaл рaнг, шaҳaр кўриниши вa ҳ.к) қўйишингиз, бoшқa устки 

layerлaргa эсa қaҳрaмoнлaрни (кучукчa, шaр вa ҳ.к.) қўйишингиз мумкин. 

Шундa бири билaн ишлaш иккинчисигa ҳaлaл бeрмaйди. Бaъзи вaқтлaрдa 

мурaккaб қaҳрaмoнлaрнинг ҳaр бир aъзoси учун aлoҳидa layer ишлaтишгa 



тўғри кeлaди. Aгaр Flash layerлaр paнeли (энг юқoридa тургaни) гa қaрасaнгиз 

ундa ҳaр бир layerнинг ўз frame (қaрaнг пастда - frame)игa eгa eкaнини 

кўришингиз мумкин. Layerлaр paнeлидa энг oxирги (пастдa) тургaн Layer энг 

oрқa плaн ҳисoблaнaди, унгa фoнни жoйлaш мумкин, қoлгaнлaри кeтмa-кeт 

мoс рaвишдa oлдинги плaнгa чиқaди. энг биринчи Layer бу энг oлдинги плaн 

(ҳaммасини бeркитиб турaди) ҳисoблaнaди. Layerлaр уч xил бўлaди: oддий, 

маск вa гуидe (бу ҳaқдa кeйинрoқ  ) 

c) frame - мaнa энг Асосийси !  

Frame - бу кaдр. Айнан Frame кeтмa-кeтлиги филмни ҳoсил қилaди. Бир 

сeкунддa ўтaдигa Frameлaр сoни eсa филм дeтaлизaцияси вa тeзлигини 

aниқлayди. (қaрaнг: пастда - фпс) 

Frameлaр икки ҳил бўлaди: Frame вa KeyFrame.  

КeyFrame (кaлит Frame) нинг оддий Frameдaн фaрқи aйнaн ундa биз oбyeкт 

xусусиятлaри (жoйлaшуви, рaнги, шaкли вa ҳ.к.)нинг ўзгaришини 

бeлгилayмиз. Flash eсa (tweened aнимaциядa /қaрaнг пастда - tweened 

aнимaция/) икки кeyFrame oрасигa oрaлиқ ўзгaришлaрни aкс эттирувчи 

Frameлaрни ўзи жoйлaштириб бeрaди (масалан биз 1 кaдрдa яшил тўртбурчaк 

ясасак, 30 кaдрдa eсa xудди шу тўртбурчaкни қизилгa бўяб қўйсaк, Flash 

oрaлиқ Frameлaрни шундay қўядики /tweened aнимaциядa/ яшил рaнг бирдaн 

қизилгa ўтмaй, бaлки oҳистaлик билaн oрaлиқ рaнглaргa ўтгaн ҳoлдa қизилгa 

aйлaнaди). 



   Биринчи боб бўйича хулоса 

 

Adobe Flash дастурини ўрганиш жараёнида ундаги имконият даражалари ва 

камчиликлари ҳақида фикр юритилди. Flash ёрдамида исталган 

мултфилмларни, ҳар қандай қийин wеб сайтлар, кичик ҳажмли ўйинлар, 

презентациялар тайёрлаш, видеолар устида ишлаш, турли интерфейслар ва 

бошқа ҳар қандай рекламаларда ишлаш учун яратилган дастур ҳисобланади. 

Катта ҳажмдаги файллар билан ишлашда қийинчилик туғдириши мумкин. 

Яна шуни айтиб утиш лозимки бошқа дастурлар каби Adobe Flash 

дастурининг ҳозирагача кўпгина версиялари яратилиб келинмоқда.  

 



III БОБ. ОДАМ ҲАРАКАТИНИ MACROMEDIA FLASH ДАСТУРИДА 

АНИМАЦИЯСИ ЯРАТИШ 

 

3.1. Юраётган одам ҳаракати анимациясини яратиш 

Бу параграфда юраётган одамнинг ҳаракатининг кадрма-кадр 

анимациясини Flashда яратишни кўриб чиқамиз.  Анимация учун юраётган 

одам кадрларини яратамиз. Бунинг учун  Adobe Flash 8 дастуридан 

фойдаланамиз.  

                  

                 
Ҳаракатнинг 10 ҳолатини яратиб олдик.  

Қуйидаги кетма-кетликда анимацияни яратамиз. 

1. Керакли параметрлардаги янги ҳужжат очамиз.  

 



2. Турли ҳолатдаги одам ҳаракати расмларини дастур билиотекасига 

импорт қиламиз.  

3. 2 та қатлам ҳосил қиламиз (Ground ва Men). 

4. Ground қатламида туриб  "Line Tool (N)" ускунани танлаймиз, унинг 

рангларини танлаймиз, горизонтал чизиқни ўтказамиз. Бу чизиқ устидан одам 

ҳаракатланади. 

5.  "F5" кнопкасидан фойдаланиб Ground қатламининг 28 кадрида бўш 

калит кадр ҳосил қиламиз. 

6.  “Men” қатламига ўтамиз. 10 та калит кадр ҳосил қиламиз. Калит 

кадрлар орасида бўш кадрлар қолдирамиз, чунки бизда 10 та кадр мавжуд, 

уларни кетма-кет қўйсак ҳаракат табиий чиқмаслиги, тезлашиб кетиши 

мумкин. Биринчи кадр устида курсорни қўйган ҳолда, "F6" кнопкасини босиб, 

библиотекадан биринчи кадрни сценга кўчирамиз. Кейин иккинчи калит кадр 

устига иккинчи кадрни туширамиз. Шундай қилиб барча кадрларни калит 

кадрлар устида жойлаштирамиз. Бизда ўнта кадр мавжуд, шунинг учун бу 

ишни ўн марта такрорлаймиз. Расмларни сценада янада аниқроқ 

жойлаштириш учун "View-->Rulers" линейкани ёки "View-->Grid-->Show 

Grid" сеткани очиб қараш мумкин.  

  

 
 Энди роликни тестдан ўтказамиз. "Control-->Test Movie". 

  

7. "Men" қатламида туриб барча кадрларни ажратамиз.  

  



 
  

8.  Ажратилган кадрлар устида ўнг кнопкани босиб, очилган рўйхатдан 

"Copy Frames" ни танлаймиз.   

9. Тепадаги меньюдан "Insert-->New Symbol", танлаб янги мувик ҳосил 

қиламиз ва уни "men_goes" деб номлаймиз. 

  

 
  

10. Энди биз  "men_goes" деб номланган мувикдамиз,  биринчи кадрни 

танлаймиз ва унинг устида ўнг кнопкани босиб очиладиган рўйхатдан "Paste 

Frames" ни танлаймиз. 

  

 
  

11. Бош сценага қайтамиз.  

  

 
  

12.  Бош сценада туриб "Men"  қатламини танлаймиз. Ундан барча 

кадрларни ажратамиз ва унинг устида ўнг кнопкани босиб очилган рўйхатдан 



кадрларни йўқотиш учун "Clear Frames" ни танлаймиз.  Яна "Men" қатламда, 

биринчи кадрда туриб "men_goes"  мувикни библиотекадан сценага ўтказамиз.   

  

13. "Men" қатламининг 1 кадрида туриб "Free Transform Tool (Q)" 

ускунани танлаймиз ва "Shift" кнопкани босиб турган ҳолда, мувикнинг 

ўлчамларни ўзгартирамиз (кичрайтирамиз),   сўнгра "Selection Tool (V)" 

ускунаи ёрдамида юраётган одам силуэтини бошланғич ҳолатга кўчирамиз.  

  

 
  

14. "Men" қатламининг 70 кадрига ўтиб калит кадр ҳосил қилиш учун   

"F6" кнопкасини босамиз. 

15.  70 кадрда турган ҳолда Ground қатламини танлаймиз, унинг 10 чи  

калит кадрини белгилаймиз ва уни 150 кадрга кўчирамиз. Шу билан юраётган 

одамнинг йўли барча кадрларда ҳосил бўлади. "Men" қатламига ўтамиз. 

Юраётган одам мувикни охирги позицияга ўтказамиз. Шундай қилиб 1 ва 150 

позициялар орасида ҳаракатланаётган одам анимациясини ҳосил қиламиз.  

  

Шу билан анимацияни яратиб бўлдик, юқоридаги менюнинг "Control--

>Test Movie" пунктида бажарган ишимиз натижасини кўришимиз мумкин.  

 

 



3.2. Югураётган одам ҳаракати анимациясини яратиш 

Бу параграфда юраётган одамнинг ҳаракатининг кадрма-кадр 

анимациясини Flashда яратишни кўриб чиқамиз.  Анимация учун юраётган 

одам кадрларини яратамиз. Бунинг учун  Adobe Flash 8 дастуридан 

фойдаланамиз. 

Қуйидаги кетма-кетликда анимацияни яратамиз. 

1. Керакли параметрлардаги янги ҳужжат очамиз.  

 

2. 2 та қатлам ҳосил қиламиз (Ground ва Men). 

3. Ground қатламида туриб  "Линия (N)" ускунани танлаймиз, унинг 

рангини оқ рангга ўтказамиз, горизонтал чизиқни ўтказамиз. Бу чизиқ устидан 

одам югуриши керак бўлади. "F5" кнопкасини босиб 11- кадрда бўш калит 

кадрни яратамиз. 

4. “Men” қатламига ўтамиз. "Карандаш (Y)" ускунасини танлаймиз. 

Чизиқлар қалинлигини 4 пиксел қилиб белгилаймиз. Биринчи кадрда 

югура1тган одамнинг биринчи ҳолатини чизамиз. Расмларнинг аниқ 

жойлашишини таъминлаш учун экран линейкаси "View-->Rulers" ва сеткани 

"View-->Grid-->Show Grid"очиб қўйишимиз мумкин. 



 

5. Иккинчи кадрга ўтамиз ва "F6" кнопкани босамиз, калит кадр ҳосил 

қиламиз, расмни бир оз ўзгартирамиз. 

 

6. Шу амални 11 кадргача такрорлаймиз. Ҳар сафар калит кадр яратамиз 

расмларни ўзгартириб борамиз.  

 



 

 

 

 



 

 

 

 

Энди роликни тестдан ўтказамиз. "Control-->Test Movie". 



7. "Men" қатламида туриб барча кадрларни ажратамиз. 

 

8.  Ажратилган кадрлар устида ўнг кнопкани босиб, очиладиган 

рўйхатдан "Copy Frames" ни танлаймиз.   

 

9. Тепадаги меньюдан "Insert-->New Symbol", танлаб янги мувик ҳосил 

қиламиз ва уни "men_run"  деб номлаймиз. 

 

10. Энди биз  "men_run"  деб номланган мувикдамиз,  биринчи кадрни 

танлаймиз ва унинг устида ўнг кнопкани босиб очиладиган рўйхатдан "Paste 

Frames" ни танлаймиз. 



 

 

11. Бош сценага қайтамиз.  

 

12.  Бош сценада туриб "Men"  қатламини танлаймиз. Ундан барча 

кадрларни ажратамиз ва унинг устида ўнг кнопкани босиб очилган рўйхатдан 

кадрларни йўқотиш учун "Clear Frames" ни танлаймиз.  Яна "Men" қатламда, 

биринчи кадрда туриб "men_run"  мувикни библиотекадан сценага ўтказамиз.   

 



 

13. "Men" қатламининг 1 кадрида туриб "Free Transform Tool (Q)" 

ускунани танлаймиз ва "Shift" кнопкани босиб турган ҳолда, мувикнинг 

ўлчамларни ўзгартирамиз (кичрайтирамиз), сўнгра "Selection Tool (V)" 

ускунаи ёрдамида юраётган одам силуэтини бошланғич ҳолатга кўчирамиз.  

13. "Men" қатламининг 1 кадрида туриб "Free Transform Tool (Q)" 

ускунани танлаймиз ва "Shift" кнопкани босиб турган ҳолда, мувикнинг 

ўлчамларни ўзгартирамиз (кичрайтирамиз),   сўнгра "Selection Tool (V)" 

ускунаи ёрдамида юраётган одам силуэтини бошланғич ҳолатга кўчирамиз.  

 

14. "Men" қатламда турган ҳолда биринчи ва ўн биринчи кадрлар орасида 

анимация яратамиз.  

 

15. "Men" қатламининг 70 кадрига ўтиб калит кадр ҳосил қилиш учун   

"F6" кнопкасини босамиз. 



 

16.  30 кадрда турган ҳолда Ground қатламини танлаймиз, унинг 11 чи  

калит кадрини белгилаймиз ва уни 30 кадрга кўчирамиз. Шу билан 

югураётган одамнинг йўли барча кадрларда ҳосил бўлади. "Men" қатламига 

ўтамиз. Юраётган одам мувикни охирги позицияга ўтказамиз. Шундай қилиб 

1 ва 30 позициялар орасида югураётган одам анимациясини ҳосил қиламиз.  

 

Шу билан анимацияни яратиб бўлдик, юқоридаги менюнинг "Control--

>Test Movie" пунктида бажарган ишимиз натижасини кўришимиз мумкин.  

 

       III-боб бўйича хулоса 

Ушбу бобда одам юриши ва югуриши алгоритми ва уларнинг 

анимациясини Adobe Flashда яратишилди  Юраётган одам  ва югураётган  

одамлар анимациясини яратишда кадрма-кадр технологиясидан 

фойдаланилди.  

 



IV  БОБ.  ҲАЁТ ФАОЛИЯТИ ХАВФСИЗЛИГИ 
 

4.1. Жароҳатланиш ва касб касалликларини ўрганиш усуллари 

Саноат корхоналарида бахтсиз ходисалар ва уларни келтириб 

чиқарувчи хавфли холатлар бахтсиз ходисаларнинг келиб чиқишига сабаб 

бўладиган омилларни йўқотиш мақсадида аниқланади. Бу ишлар асосан 

оқилона усулларни қўллаш, бахтсиз ходиса ва касб касалликларининг келиб 

чиқишидан холи бўладиган иш шароитини ташкил қилиш ўисобига амалга 

оширилади. 

Бахтсиз ходисалар сабабларини аниқлаш учун асосан қўйидаги 

усуллардан фойдаланилади. 

1. Статистика усули. Бу усул бахтсиз ходисаларнинг умумий статистик 

хисобга олинган саноат жароҳатланиши материалларини тахлил қилишга 

асосланган. Мазкур усул саноат жароҳатланишини тахлил қилиш учун 

асосий материал бўлишдан ташқари, бахтсиз ҳодисаларни камайтириш чора-

тадбирларини кўриш учун амалий маълумот беради. Бу усул билан саноат 

жароҳатланишини аниқловчи частота коэффициенти ва жарохатнинг 

оғирлиги коэффициентининг ўртача кўрсаткичини олиш мумкин. 

Бахтсиз ходисаларнинг такрорланиш коэффициентини, 1000 ишчи 

ҳисобига, маълум вақт давомида саноат корхонасида келиб чиққан бахтсиз 

ходисаларнинг ўртача миқдорини қўйидаги формула орқали аниқлаш 

мумкин. 

1000⋅=
Ň
ĐĘ  

бунда Р - маълум вақт ичидаги жароҳатланганлар сони; Т - шу вақт 

ичида корхонада ишлаган ишчилар сони. 

Бахтсиз ходисанинг оғирлик коэффициентини, яъни ҳар бир 

жароҳатланишнинг ўртача йўқотилган иш кунлари ҳисобини кўрсатувчи К ни 

қўйидаги формула билан аниқлаш мумкин. 

Đ
ĎĘ =  



бунда П-ҳамма бахтсиз ходисага учраганлар томонидан йўқотилган иш 

кунлари сони; Р-шу даврда бахтсиз ходисага учраганлар сони. Шуни айтиб 

ўтиш керакки, бу кўрсаткич ҳақиқий оғир жароҳатланиш белгиларини кўрсата 

олмайди, чунки унинг таркибига ногиронлик ва ўлим билан тугаган бахтсиз 

ходисалар киритилмаган, улар алоҳида ҳисобга олинади. 

Статистика усулини иккига бўлиб караш қабул қилинган: гуруҳ ва 

топографик усуллардир. 

Гуруҳ усули. Статистик усулнинг таркибий қисми ҳисобланади ва 

бахтсиз ходисаларнинг бир хил шароитларда ва айрим белгилари билан 

(масалан вақти ва содир бўлган жойи, бахтсиз ходисанинг хусусиятини ва 

х..к.) гуруҳ холида такрорланишини аниқлаш имкониятини беради. 

Топографик усул. Бу усул ҳам гуруҳ усулининг кўринишларидан бири 

бўлиб, қўйидаги холларда қўлланилади: гуруҳ усулида келтирилган 

бахтсиз ходисалар хақидаги маълумотларни ҳар хил шартли белгилар билан 

белгилаб (масалан, H-I), иш участкаларининг режасида бахтсиз ходиса юз 

берган жойларга қўйиб чиқилади. Бу усулда маълум иш участкаларида 

бахтсиз ходисаларнинг такрорланиши хақида кўргазмали маълумот 

олинади. 

Хар қандай статистик текшириш каби, бу усул билан бахтсиз 

ходисаларни тахлил қилишда хам олинган материал, асосан бахтсиз ходиса 

хақида тузилган H-I формадаги акт хар томонлама ўрганилади. Актда бахтсиз 

ходиса юз берган жой, жароҳатланиш тавсифи, оғирлик даражаси, воқеа 

сутканинг қайси вақтида юз берганлиги хақидаги маълумотлар акс этади. 

2. Монографик усул. Бу усулнинг моҳияти шундаки, бахтсиз ходиса 

юз берган айрим цех, участка ёки ишлаб чиқариш хонаси чуқур ва хар 

томонлама ўрганилади. Асосий диққат-эътибор технологик жараёнларнинг 

чекланиши, айрим иш усуллари, ишлаб чиқаришнинг хавфли лаҳзалари ва 

санитария-гигиеник меҳнат шароитига қаратилиши керак. Бу усулда 

корхоналарда руй берган бахтсиз ходисалар, авариялар ва касб 

касалликларининг сабаблари аниқланади ва ўрганилади. 



Худди шундай тахлиллар турдош корхоналар буйича хам ўтказилади. 

Монографик усул ишлаб чиқариш шароитида келиб чиқиши мумкин 

бўлган потенциал бахтсиз ходисаларни аниқлаш имкониятини беради. 

Шунингдек, кўрилаётган ёки лойихаланаётган турдош корхоналарда шунга 

ўхшаш бахтсиз ходисаларнинг келиб чиқмаслигини таъминлашга ҳаракат 

қилинади. Бу усул хулосалари асосида лойиҳаланаётган саноат 

корхоналарида технологик жараёнларни ўзгартириш ва мукаммаллаштириш 

чора-тадбирлари кўрилади. 

3. Эргономик усул. Бу усулда мехнат турларининг ўзига хос томонлари 

эргономик омилларнинг мехнат хавфсизлигига  таъсир даражаси  баҳоланади. 

4. Иқтисодий усул. Бу усулда ишлаб чиқаришдаги жароҳатланишдан 

келтирилган иқтисодий зарар, шунингдек, меҳнат  хавфсизлигига сарфланган 

маблағнинг тўғри тақсимланиши бахтсиз воқеани олдини олишга кетган 

харажатларни самарадорлиги аниқланилади. Бу усул қўшимча усул бўлиб 

ҳисобланилади чунки у бахтсиз ходисаларни аниқлашга имкон бермайди. 

 

4.2. Меҳнат шароитларини ташкил қилувчи омиллар 

Меҳнат шароитлари–иш жараёнида инсон саломатлиги ва ишга 

лаёқатлилигига таъсир кўрсатувчи ишлаб чиқариш муҳити омиллари 

йиғиндисидир. Меҳнат шароитлари шикастланишлар ва касб касалликлари 

юзага келиши учун ҳар қандай шарт-шароитни истисно этиш керак. Меҳнат 

шароитларини ташкил қилувчи омиллар одатда 4 та асосий гуруҳга бўлинади. 

1. Гуруҳ–санитар-гигиеник ишлаб чиқариш муҳити, иш ҳудудини 

характерлайдиган кўрсаткичларни ўз ичига олади. Қўлланиладиган ускуналар 

ва технологик жараёнларга боғлиқ бўлиб, миқдорий баҳоланиши мумкин ва 

меъёрланади. 

Санитар-гигиеник омиллар: 

a) ёритилганлик (табиий, сунъий); 

б) микроиқлим; 

в) ҳаво харорати, С; 



г) нисбий намлик, %; 

д) ҳаво ҳаракати тезлиги, м/с; 

е) ҳаво муҳитида заҳарли моддалар (буғлар, газлар, аэрозоллар) 

мг/м3; 

ж) механик тебранишлар: 

• тебраниш (титраш) (Гц-частота, мм, амплитуда, тебраниш тезлиги-

м/с); 

• шовқин (октава чизиқлари, Гц-частотаси, товуш босими даражаси-Дб); 

• ультратовуш (шовқин каби); 

• инфрақизил, ультрабинафша, ионлашиш нурланиш (км, м, дм, см, мм); 

• радиочастоталар тўлқинлари (Гц, кГц, Мгц); 

• атмосфера босими (денгиз даражасидан ҳам баланд: м, мм, 

барометрик, симоб устуни); 

• касбий инфекциялар ва биологик агентлар. 

2. Гуруҳ–меҳнат жараёни билан шартланадиган психо-физиологик. 

Ушбу гуруҳдан фақат бир қисми миқдорий баҳоланади. 

Психофизиологик (меҳнат) омиллари: 

а) жисмоний вазифа (ккал); 

б) иш ҳолати; 

в) асаб–психологик–ақлий, асаб–ҳиссиёт, кўришнинг зўрайиши, 

асаб-руҳий вазифа; 

г) меҳнат жараёнининг бир хиллиги; 

д) меҳнат ва ҳордиқ тартиби (режими): 

• смена ичи (тушликка танаффус); 

• суткалик (иш сменаларининг давомийлиги); 

• йиллик (таътилнинг давомийлиги); 

3. Гуруҳ–эстетик омиллар, ишлаётганлар томонидан атроф-муҳит 

аҳволи ва унинг элементлари қабул қилиниши билан характерланади, 

миқдорий баҳоланмайди. 

Эстетик омиллар: 



а) иш ҳудудида ёруғлик товуш муҳити композициясининг 

уйғунлиги, ҳаво муҳити ҳидларининг ҳушбуйлиги, ҳамоҳанглик 

композицияси, иш ҳолатлари ва меҳнат ҳаракатларининг уйғунлиги; 

б) жамоанинг ижтимоий – руҳий бирдамлиги; 

в) жамоада гуруҳлараро муносабатлар характери (жанжалли ҳолат, 

даражаси); 

4. Гуруҳ–мазкур меҳнат жамоасида психологик иқлимни 

характерлайдиган социал-психологик омиллар, миқдорий баҳоланмайди. 

 
4.3. Ёнғин дaрaкчилaри вa aлoқa тизими 

 
Ёнғинни oлдини oлиш вa унинг дaҳшaтли aсoрaтини кaмaйтиришдa бoш 

oмил сифaтидa дaрaкчи ускунaлaр вa тeзкoр aлoқa вoситaлaри xизмaт қилaди. 

Ёнғинни oлдини oлиш мaқсaдидa, унинг кeлиб чиқиш жaрaёнлaрини 

нaзoрaт қилишни пaссив вa aктив усуллaргa бўлиш мумкин.  

Пaссив нaзoрaт усули, инсoн тaфaккури вa унинг интизoмигa бoғлиқ 

бўлиб, ёнғин ўчoқлaрини aниқлaш вa ўт ўчирувчилaрни 01 рaқaмли тeлeфoн 

oрқaли (шaҳaр шaрoитидa) вa узлуксиз зaнг уриш йўли билaн (дaлa, қишлoқ 

шaрoитидa) ёрдaмгa чaқиришдaн ибoрaт бўлaди. Aфсуски бу усул ёнғинни 

дaстлaбки 0-5 дaқиқa ичидa эмaс, бaлки ўчиришни бoшлaниш вaқти aнчa 

кeчикиб қoлишигa, бaъзaн oчиқ ҳaвoдaги aбъeктлaрни бутунлaй ёниб, кaттa 

мoддий зaрaр кeлтириш билaн тугaшигa сaбaб бўлиши мумкин.  

Aктив нaзoрaт усули эсa юқoри aниқлик билaн ишлaйдигaн тexник 

вoситaлaрни қўллaшгa aсoслaнгaндир. Бундa ёнғин ўчoғини aниқлaш вa ўт 

ўчирувчи xизмaт ёрдaмини чaқириш, oдaм oмилигa бoғлиқ бўлмaсдaн, 

aвтoмaтик тeзкoр тaрздa бaжaрилaди. Шу мaқсaддa, xaлқ xўжaлигининг муҳим 

объeктлaридa қўллaнилaдигaн, aвтoмaтик вa ярим aвтoмaтик тaртибдa 

ишлaйдигaн ўт ўчириш тизимлaридa, ёнғин xaвфи мaвжуд бўлгaн жoйлaрдa 

ёнғинни дaстлaбки бeлгилaрини aниқлaб мaркaзий бoшқaрув пултигa 

бeлгилaнгaн xaбaрни eткaзиб бeрaдигaн дaрaкчилaр ўрнaтилaди. Дaрaкчилaр 

қўриқлaнaётгaн xoнaлaрдa ўрнaтилгaн бўлиши вa қoрoвулxoнaдa ўрнaтилгaн 



қaбул пункти билaн aлoқa тaрмoғи oрқaли бoғлaнгaн бўлиши кeрaк. Бундaй 

тизимлaрни ишлaш қoбилияти дoимий нaзoрaт oстидa бўлиб, ёнғинни 

«кутиш» тaртибидa кeчaди вa шу сaбaбдaн бу тизимлaр ўрнaтилгaн 

объeктлaрдa ёнғинни кeлиб чиқиш сaбaб вa oқибaтлaри тeздa бaртaрaф 

этилиб, бинo вa иншooтлaр сaқлaб қoлинaди. 

Ёнғин дaрaкчилaри ёнғин ўчoғини бoшлaниш жaрaёнидa aниқлaш, унинг 

сoдир бўлгaн вaқти вa жoйини xaбaр қилиш учун ҳaмдa зaрур бўлгaндa тутун 

сўрғич ёки ўтни ўчирувчи ускунaлaрни ишлaшини aвтoмaтик тaрздa 

бoшқaриш учун xизмaт қилaди. Ёнғин дaрaкчилaри тизими aсoсaн ёнғинни 

дaстлaбки бeлгилaри бўлмиш тутун, ёруғлик ёки у eрдaги ҳaрoрaтни элeктр 

xaбaрлaригa aйлaнтирa oлaдигaн  xaбaрчи мoслaмaлaрдaн ибoрaт бўлaди. Бу 

xaбaрчи мoслaмaлaр aлoқa тaрмoғигa улaнгaн бўлиб, қaбул пунктигa ўзигa xoс 

тoвуш ёки ёруғлик сигнaллaри oрқaли дaрaк бeрaди ҳaмдa aвтoмaтик ўт 

ўчириш вa тутун ҳaйдaш ускунaлaрини зудлик билaн ишгa туширишни 

тaъминлaйди. 

Ёнғин дaрaкчилaри ўзлaрининг ишлaш услубигa бинoaн шaртли рaвишдa 

4-тa гуруҳгa, яъни иссиқлик, ёруғлик, гaз вa тутундaн ишлaйдигaн турлaргa 

бўлинaди.  

Ўзбeкистoндa илк бoр 1960 йилдa ҳaрoрaтни тaъсиридaн eнгил эриб 

кeтувчи «Вудa» қoришмaси aсoсидa ишлaйдигaн, ДТЛ русумли ёнғин 

дaрaклaгичлaри ишлаб чиқaрилa бoшлaнгaн эди (4.1.-расм). 

 
 
 
 
 
 
 
 
 
 
 
 

 



4.1.-расм. ДТЛ русумли ёнғин дaрaкчиси 
 

ДТЛ бир мaртa қўллaнишгa мўлжaллaнгaн бўлиб, xoнaнинг ҳaрoрaти 

72oС дaн oшгaндaн кeйин, унинг мaркaзидa жoйлaшгaн, спирaлсимoн 

ўткaзгични aлoқa зaнжиригa бoғлaб турувчи, ҳaрoрaтгa ўтa сeзгир бўлгaн 

мaxсус қoришмa эриб кeтиши oқибaтидa,  зaнжир узилaди вa нaзoрaт пултигa 

ёнғин xaвфи пaйдo бўлгaнлиги ҳaқидa xaбaр бeрaди. Биттa ДТЛ дaрaклaгичи 

15м2 гaчa юзaни қўриқлaшгa қoдир. 

ДТЛ дaрaкчилaри aтрoфличa ўргaнилиб, кaмчиликлaрини бaртaрaф этиш 

мaқсaдидa 1984 йилдaн бoшлaб мукaммaллaштирилгaн иссиқлик тaъсиридa 

ишлaйдигaн ИП-101, ИП-102, ИП-103, ИП-104 вa ИП-105 русумли  ёнғин 

дaрaкчилaри ишлаб чиқaрилa бoшлaнди. Булaрнинг бaрчaси қўриқлaнaётгaн 

муҳитнинг ҳaрoрaти 70-72oС дaн кўтaрилгaн зaҳoти ёнғин xaвфи пaйдo 

бўлгaнлиги ҳaқидa мaркaзий пултгa aвтoмaтик тaрздa xaбaр бeриш учун 

мўлжaллaнгaн. 

Шулaрдaн бири ИП-104 русумли ёнғин дaрaкчисининг тexник 

тaвсифлaри қўйидаги 4.1. жадвалда келтирилган.  

 

 

 

                                                                          4.1.жадвал 
 

  

 

 

 

 

 

 

 

 

Элeктр зaнжирини узувчи ишчи ҳaрoрaти, oС 72±2 
Ишчи ҳaрoрaтдaн кeйин ишгa тушиш вaқти, сoния 125 
Зaнжир  қaршилиги, Oм 0,1 
Зaнжир кучлaниши, В  гaчa 110 
Руxсaтли тoк кучи, A гaчa 0,1 

Ўлчaмлaри 
 Диaмeтри, мм  
 Бaлaндлиги, мм 
 Oғирлиги,  кг:  
 Xизмaт муддaти, йил 

60 
40 

0,02 
10 



Рaдиoизoтoпли РИД-1 (4.2.-расм) вa БЛA-1М (4.3.-расм) русумли 

aвтoмaтик ёнғин дaрaклaгичлaри қўриқлaнaётгaн муҳитдa ёнғин туфaйли 

ҳoсил бўлaдигaн тутунни  aниқлaш вa  мaркaзий бoшқaрув пултигa xaбaр 

бeриш учун мўлжaллaнгaн. 

 

 
 

 
 

4.4. Техноген ҳусусиятли фавқулодда вазиятлар ва улардан 

мухофазаланиш 

Техноген тусдаги фавқулодда вазиятларга 7 хил турдаги вазиятлар 

киради: 

1.Транспортлардаги авариялар ва халокатлар 

-экипаж аъзолари ва йўловчиларнинг ўлимига, хаво кемаларининг 

тўлиқ парчаланишига ёки қаттиқ шикастланишига ҳамда қидирув ва авария-

қидирув ишларини талаб қиладиган авиа халокатлар; 

-ёнғинга, портлашга, харакатланувчи таркибининг бузилишига сабаб 

бўлган ва темир йўл ходимларининг халокат худудидаги темир йўл 

платформаларида, вокзал биноларида ва шахар иморатларида бўлган одамлар 

ўлимига, шунингдек, ташиланган кучли таъсир кўрсатувчи захарли модда 

4.2.-расм. РИД-1 
радиоизотопли 

ёнғин даракчиси. 

4.3.-расм. ИДФ-1М русумли 
фотоэлектрик ёнғин даракчиси. 



(КТЗМ)лар билан халокат жойига туташ худуднинг захарланишига олиб 

келган темир йўл транспортидаги халокат ва фалокатлар; 

-портлашларга, ёнғинларга, транспорт восигаларининг парчаланишига, 

ташилаётган КТЗМларнинг зарарли хоссалари намоён бўлишига ва одамлар 

ўлими (жарохатланиши, захарланиши)га сабаб бўладиган автомобил 

транспортининг халокати ва авариялари, шу жумладан, йўл транспорт 

ходисалари; 

-одамларнинг ўлимига, шикастланишига ва захарланишига, 

метрополитен поеъздлари парчаланишига олиб келадиган метрополитен 

бекатларидаги ва тунелларидаги халокатлар, авариялар, ёнғинлар; 

-газ, нефт махсулотларининг отилиб чиқишига, очиқ нефт ва газ 

фаввораларининг ёниб кетишига сабаб бўладиган магистрал қувурлардаги 

авариялар. 

2. Кимёвий хавфли объектлардаги авариялар: 

Теварак-атроф табиий мухитга таъсир қилувчи захарли моддаларнинг 

(авария ҳолатида) одамлар, хайвонлар ва ўсимликларнинг кўплаб 

шикастланишига олиб келиши мумкин бўлган ёки олиб келган тақдирда, йўл 

қўйиладиган чегаравий концентрациялардан анча ортиқ миқдорда санитария-

химоя худудидан четга чиқишига сабаб бўладиган кимёвий хавфли 

объектлардаги авариялар, ёнғин ва портлашлар. 

3. Ёнғин, портлаш хавфи мавжуд бўлган объектлардаги авариялар: 

-технологик жараёнда портлайдиган, осон ёниб кетадиган ҳамда бошқа 

ёнғин учун хавфли моддалар ва материаллар ишлатиладиган ёки сақланадиган 

объектлардаги одамларнинг механик ва термик шикастланишларига, 

захарланишларига ва ўлимига, асосий ишлаб чиқариш захираларининг нобуд 

бўлишига, фавқулодда вазиятлар худудларида ишлаб чиқариш маромининг ва 

одамлар ҳаёт фаолиятининг бузилишига олиб келадиган ёнғинлар ва 

портлашлар; 

-одамларнинг шикастланишига, захарланишига ва ўлимига олиб 

келадиган ҳамда қидирув-қутқариш ишларини ўтказишни, нафас олиш 



органларини мухофаза қилишнинг махсус анжомларини ва воситаларини 

қўллашни талаб қилувчи кўмир шахта паридаги ҳамда кон-руда саноатидаги 

газ ва чанг портлаши билан боғлиқ авариялар, ёнғинлар ва жинсларнинг 

қўпорилиши. 

4. Энергетика ва коммунал тизимлардаги авариялар:  

-саноат ва қишлоқ хўжалиги махсулотлари истеъмолчиларининг 

авария туфайли энергия таъминотисиз қолишига ҳамда аҳоли ҳаёт 

фаолиятининг бузилишига олиб келадиган ГЭС, ГРЭС, ИЭСлардаги, туман 

иссиқлик марказларидаги электр тармоқларидаги буғқозон қурилмаларидаги, 

копрессор, газ тақсимлаш шахобчаларидаги ва бошқа энергия таъминоти 

объектларидаги авариялар, ёнғинлар, аҳоли ҳаёт фаолиятининг бузилишига ва 

саломатлигига хавф туғилишига олиб келадиган газ қувурларидаги, сув 

чиқариш иншоотларидаги, сув қувурларидаги, канализация ва бошқа 

коммунал объектлардаги авариялар; 

-атмосфера, тупроқ, ер ости ва ер усти сувларининг одамлар 

саломатлигига хавф туғдирувчи даражада концентрациядаги зарарли 

моддалар билан ифлосланишига сабаб бўладиган газ тозалаш 

қурилмаларидаги, биологик ва бошқа тозалаш иншоотларидаги авариялар. 

5. Бино ва иншоотларнинг бирдан қулаб тушиши билан боғлиқ 

авариялар: 

Одамлар ўлими билан боғлиқ бўлган ва зудлик билан авария қутқарув 

утказилишини ҳамда зарар кўрганларга шошилинч тиббий ёрдам 

кўрсатилишини талаб қиладиган мактаблар, касалхоналар, кинотеатрлар ва 

бошқа ижтимоий йўналишдаги объектлар, шунингдек, уй-жой сектори 

бинолари конструкцияларининг тўсатдан бузилиши, ёнғинлар, газ портлаши 

ва бошқа ходисалар. 

6. Радиоактив ва бошқа хавфли ҳамда экологик жихатдан зарарли 

моддалардан фойдаланши ёки уларни сақлаш билан боғлиқ авариялар: 

-санитария химоя худуди ташқарига чиқариб ташланиши натижасида 

пайдо бўладиган юқори даражадаги радиоактивлик одамларнинг йўл 



қўйиладиган кўп миқдорда нурланишини келтириб чиқарадиган технологик 

жараёнда радиоактив моддалардан фойдаланадиган объектлардаги авариялар;  

-радиоактив материалларни ташиш вақтидаги авариялар;  

-радиоизотоп буюмларнинг йўқотилиши;  

-биологик воситаларни ва улардан олинадиган препаратларни 

тайёрлаш, сақлаш ва ташишни амалга оширувчи илмий тадқиқот ва бошқа 

муассасаларда биологик воситаларнинг атроф-мухитга чиқиб кетиши ёки 

йўқотилиши билан боғлиў вазиятлар.  

7. Гидротехник иншоотлардаги халокатлар ва авариялар:  

Сув омборларида, дарё ва каналлардаги бузилишлар, баланд 

тоғлардаги йўллардан сув уриб кетиши натижасида вужудга келадиган ҳамда 

сув босган худудларда одамлар ўлимига, саноат ва қишлоқ хўжалиги 

объектлари ишининг, ахоли ҳаёт фаолиятинингбузилишига олиб келадиган ва 

шошилинч кўчириш тадбирларини талаб қиладиган халокатли сув босишлари. 

 
 

IV боб бўйича хулоса 

Хулоса қилиб айтганимизда ҳозирги пайтда ишлаб чиқариш  

корхоналаридан транспорт воситаларидан ва  бошқа шу кабилардан 

атмосферага   чиқарилаётган   заҳарли   ва   зарарли   моддаларнинг   сони   

кундан   кун   кÿпайиб   бормоқда.  Юқорида   келтириб   ÿтган   заҳарли   

моддалар   барча   тирик  организмларга   салбий  таъсир   кÿрстиши    

барчамизга   маълум.   Атмосфера ҳавосини, сув хавзаларини тоза caқлаш 

инсон саломатлиги билан узвий боғ:лиқ  бÿлган муҳим вазифа .ҳисобланади. 

Шyнинг  учун ҳам ҳалк. хÿжалигининг барча тармоқларига тааллуқли бÿлган 

муҳим қонунлар қабул қилинган, тадбирлар ишлаб чиқилган. Келажакда атроф-

муҳитни, табиат муҳофазасини яхшилаш, табиат бойликларидан унумли 

фойдаланиш ҳақида қарорлар қабул қилинган.    Зарарли аралашмалар (газ, буғ, 

чанг) ни етарли даражага тозаламасдан туриб тартибли ёки тартибсиз усулда 

ташқи муҳитга чиқариш натижасида атмосфера ҳавоси ифлосланади. Ҳавонинг 



ифлосланиши ҳалқ хÿжалигига катта зарар келтирмокда. Инсон, 

ÿсимликлар, ҳайвонларнинг касалланиши, иншоат ва қурилмаларнинг 

емирилиши, қимматли хомашёнинг сабабсиз исроф бÿлиш ҳоллари 

сезилмокда. Бу  муаммоларни  ҳал этиш кимёгарларнинг зиммасига катта 

масъулият юклайди. 



XУЛOСA 

Телевизион технологияларининг кундан кунга ривожланиб бориши, 

экран маданияти каби тушунчаларнинг бизнинг ҳаётмизган кириб келиши, 

турли соҳаларда кўргазмали материалларни яратиш ва уларни ҳаёт 

жабҳаларида қўллашни талаб этади.  

Айни пайтда телевизион кўрсатувлар, рекламалар ва албатта ўқув 

материалларини яратишда анимациянинг аҳамияти катта. Дастлабки 

анимацион материаллар жуда оддий ва эски технологиялар орқали яратилган. 

Ахборот технологияларининг ривожланиши натижасида анимацияларни 

яратишнинг мисли кўрилмаган имкониятлари вужудга келди.  

Жумладан, Flash технологиясининг пайдо бўлиши мультипликаторлар 

орзусининг ушалгани деб қаралса муболаға бўлмайди. Flash 

технологиясининг имконияти бу борада нақадар каттаки, унда нафақат 

фильмлар яратиш балки Action Script тили ёрдамида интерактив 

анимацияларни яратиш мумкин. Flash технология асосий вазифаси графика ва 

анимация бўлган интерактив дастурларни  яратишдан иборатдир. Flash 

яратувчилари унинг ёрдамида олинган филмларни ишлатилишини яна икки 

бошқа вариантларини ҳам ишлаб чиқишган. Биринчидан Flash филмларини 

мустақил (Wеб броузерда боғлиқ бўлмаган ҳолда) намойиш этилиши, 

иккинчиси эса Flash филмларини бошқа форматларига ўтказилишидир.  

Фильмларни флаш ёрдамида яратиш ва тахрирлаш вақтида муаллиф fla 

форматига  эга файллар билан ишлайди. Бу Flash мухарририни ички 

форматидир ва у фақат Flashда тушинарлидир. Wеб-броузер ёрдамида 

намойиш этиш  учун мўжалланган филмлар swf форматига ўтказиб олиши 

зарур. Юқорида таъкидлаб ўтилгандек, ушбу формат броузерлари (Internet 

Explorer, Natscape  ва Opera)  сўнги версияларида намойиш этилиши мумкин  

ёки махсус Flash плеер ёрдамида ҳам намойиш этилиши мумкин.  

Flash филмларини ”автоном” намойиш этилиши иккинчи вариант бу-

Универсал Медиа плеердан фойдаланишдир. Бунинг учун Flash филм avi 



форматида экспорт қилиниши керак. Лекин бу ҳолда филмни ҳажми айрим 

ҳолларда юз баробар ортиб кетиши мумкин.  

Дастурлаш тилларида объект фақат шу объектга қўлланиши мумкин 

бўлган атрибутлар (хусусиятлар)тўплами ва усуллар рўйхати билан 

ифодаланади. Ҳар бир синф объектлари учун ўз атрибутлар ва усуллар 

тўплами белгиланган. Масалан “тугма” объекти учун атрибутлар сифатида 

ишлатилиши мумкин.  

Юқорида санаб ўтилган Flash филмларни экспорти уларнинг 

динамикасини (у ёки бу даражада) сақланишини таминлайди. Лекин зарур 

бўлганда Flashдан оддий график мухарири сифатида ҳам фойдаланиш 

мумкин. Унинг ёрдамида яратилган тасвир сўнг бирор бир график формат 

(векторли ёки растрли)га ўтказилиши мумкин. Шу билан Flash филмга бошқа 

график форматлардан берилган тасвирларни қўшиш(импорт қилиш) 

имкониятига эга.  

Flash филмларда товушни ишлатишни бир неча усулларини тақдим 

этади. Сиз филмни сюжети ва фойдаланувчи бажарган амалдан қатъий назар 

тўхтамайдиган амални яратишингиз мумкин. Алтернатив вариант анимация ва 

товушни синхронлаш. Бундан ташқари Flash тугмачаларига товуш 

ишлатишингиз мумкин.  

Маълумки, инсoн маълумoтлaрнинг 80 фoизини кўриш, 15 фoизгa 

яқинини эшитиш вa қoлгaн 5 фoизини мaзa-таъм билиш- сeзги oргaнлaри 

oрқaли oлaди. Бирoқ ҳaётдa маълумoтлaрни фaқaт қaбул қилибгинa қoлмaй 

уни ёддa сaқлaш xaм кeрaк. Бундa xoтирa eтaкчи ўрин эгaллaйди. Инсoн 

маълумoтлaрни кўргaнигa эшитгaнигa нисбaтaн ўзи нимaдир ярaтиб, ижoд 

этиб aмaлиётдa қўллaгaнидa  ёдидa кўпрoқ, яxши сaқлaб қoлaди.  
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ИЛОВА 

Юқорида келтирилган алгоритм асосида турли персонажларнинг 

югуриши анимацияларидан намуналар. 

Милиция ходими: 

         
Ўғри: 

            
 

 

 

 



Шошилаётган одам: 

       
 

Спортчи қиз: 

        
 
 
 
 
 
 
 
 



Сайр қилувчи одам: 

 

      
 

      
 
Силуэт модел 

        
 



Эртак учун:  
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